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In This Guide
Agilent has prepared this manual as a technical reference for the ProSize data
analysis software for use with the Fragment Analyzer, ZAG DNA Analyzer and
Femto Pulse parallel electrophoresis systems.
This document includes software system requirements, installation procedures,
software operation, troubleshooting guide, and technical support information.
This document is intended for use by technical personnel that are proficient with
analytical instrumentation operation. A certain level of training and expertise is
assumed and fundamentals are not addressed herein. Information is presented in
a section-by-section format using screen captures and written descriptions. If
questions remain after reviewing a given topic, please contact your
corresponding Agilent Support or Service Representative.

1

ProSize System Overview
This chapter gives an overview about the ProSize data analysis software.

2

ProSize System Requirements and Installation
This chapter provides information on the requirements and installation
instructions for the ProSize software.

3

ProSize Main Screen
This chapter provides an overview of the ProSize software main screen with the
functions and menus available to the user. The file menu for opening and closing
data files is also covered in this chapter.

4

ProSize Configuration
This chapter provides an overview of the Global Configuration dialog of the ProSize
software. It also provides information on setting individual configuration
parameters in opened data files.

5

ProSize Size Calibration Screen
This chapter describes the size calibration screen (also referred to as calibration
curve screen). The calibration curve screen is used to select the conditions for
calibrating the size of unknown sample peaks/smears.
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6

ProSize Overlay Samples
This chapter gives an overview of the possible ways to compare samples in the
ProSize software.

7

Exporting Data from ProSize
This chapter provides an overview of the options available for exporting processed
data from the ProSize software. The following sections describe how to open the
Export Data window; provide an outline of various data export options; describe
how to perform data export; and give examples of exported data.

8

Generating Reports from ProSize
This chapter provides an overview of the options available for generating reports
from the ProSize software. The following sections describe how to open the
Generate Report window; provide an outline of various report generation options;
describe how to perform the report generation; and give examples of reported
data.

9

ProSize View Capillary Positions
This chapter briefly covers the tools and functions of the View Capillary Positions
window.

10

ProSize Troubleshooting Guide
This chapter gives an overview of troubleshooting the ProSize software.

11

Batch Processing Using ProSize
This chapter explains how to perform a batch process and provides an outline of
the various exporting options.

12

ProSize Enhanced Security Features
This chapter explains how to perform a batch process and provides an outline of
the various exporting options.
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ProSize Data Analysis Software 8

This chapter gives an overview about the ProSize data analysis software.
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ProSize System Overview
About the System

About the System
ProSize Data Analysis Software
Agilent’s ProSize software is designed for analyzing the raw data from the
parallel capillary electrophoresis instruments and reporting the size (in base pairs
for dsDNA or nucleotides for RNA) and concentration (in ng/mL or nmol/L) of
separated DNA or RNA fragments. The ProSize software performs the following
general functions:
•

Reads the raw data files generated from the instrument operational software.

•

Provides calibration of DNA size (in bp) or RNA size (in nt) from standard
mixtures and conversely measures DNA/RNA size of unknown fragments in a
sample.

•

Provides quantitative measurements of DNA/RNA concentrations present in a
sample either from relative comparisons to an internal/external standard peak
or by comparison to a calibration DNA/RNA ladder.

•

Exports size and concentration data as well as raw electropherogram trace
data (time vs. fluorescence intensity) in a generic comma separated values
(.csv) file format; and digital electropherogram trace or gel view images in .jpg,
.bmp, or .png image formats.

•

Generates PDF format sample reports containing user specified information
including measured DNA/RNA size, DNA/RNA concentration, digital gel
images, experimental information, and/or other various calculated sample
properties.

•

Provides option for enhanced security features and digital signature
generation.

This manual serves as a guide to the ProSize software and will assist the user in
taking advantage of the many benefits of the parallel capillary electrophoresis
instruments.
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ProSize Software Installation Instructions 13
Starting the ProSize Program 16
Exit the ProSize software 17

This chapter provides information on the requirements and installation
instructions for the ProSize software.
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ProSize System Requirements and Installation
System Requirements

System Requirements
General Software Requirements
Report Review
A PDF viewer is required to read Adobe PDF formatted reports.
Install the most recent version of Adobe Reader. The software is available free of
charge for download at www.adobe.com.

Data File Export
•

The ProSize software exports data in a generic comma-separated values
(.csv) file format, which can be read by most spreadsheet and database
management programs. Install a spreadsheet program (for example, Excel,
OpenOffice) to open and read exported .csv files.

•

Electropherogram and digital gel images are exported in a .jpg, .bmp, or .png
image format. A suitable program for viewing these file formats should be
installed.

Operating System
The ProSize software must be installed on a computer running a Windows
operating system to function properly.
Table 1

Supported operating systems

Operating System

Details

Windows

Windows 7 or Windows 10, 32-bit or 64-bit
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PC Recommendation
The table provides the recommended hardware configuration for the ProSize
software.
Table 2

12

Recommended hardware configuration

Item

Details

Processor speed (CPU)

Intel Core 2, or faster

Physical memory (RAM)

4 GB

Hard disk

500 GB (for accommodation of raw data files)

Graphic resolution

1280 x 800 minimum screen resolution
1280 x 1024 recommended
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ProSize Software Installation Instructions
To Install the Software
1 Download the appropriate installer from the Agilent website.
2 Navigate to the folder ProSize data analysis software.
3 Run the installer (640,980 KB) and follow the instructions and prompts
provided by the installation wizard:

Figure 1

Default directory locations for the ProSize data analysis software and supporting National
Instrument software

a Provide the installation directory. The default directory is
C:\ProSize data analysis software\.
A shortcut of the ProSize software is created in the Start menu.
Supported software from National Instruments will also be installed under
C:\Program Files\National Instruments\.
b Complete the following installation steps.
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ProSize System Requirements and Installation
ProSize Software Installation Instructions

c Restart the computer to complete the installation process.
Upon successful installation of the ProSize software, several sub-folders
will have been created within the C:\ProSize data analysis software\
directory (see Figure 2):
•

Configurations: This folder contains ProSize global configuration setting
files, optimized for different application kits for the parallel capillary
electrophoresis instruments.

•

Ladders: This folder contains ProSize sizing ladder information files (.txt
format), for use with different application kits for the parallel capillary
electrophoresis instruments.

•

Support: This folder contains supporting files for ProSize software
operation.

•

Training Test Runs: This folder contains data files, for use with a set of
tutorial videos which are loaded upon installation of the ProSize software.

•

Video: This folder contains ProSize tutorial videos, which can be accessed
via the Help menu as described in the following section.

Figure 2
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Sub-folders created within the C:\ProSize data analysis software\ directory
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ProSize Software Installation Instructions

4 Update the Configurations, Ladders and Video folders within the
C:\ProSize data analysis software\ directory to the latest versions. You can
obtain the most recent version of software and files from Agilent support.
To update the folder files:
a Navigate to C:\ProSize data analysis software\.
b Delete the contained folders Configurations, Ladders, and Video.
c Paste the folders Configurations, Ladders, and Video supplied from Agilent
into the same directory C:\ProSize data analysis software\.

NOTE

After installation of the ProSize 3.0 software, the system will install
System.Data.SQLite. Please follow all screen instructions on this installation.

To properly read PDF reports:
1 Install the latest version of Adobe Reader on your computer. This software is
available free of charge for download at www.adobe.com.
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ProSize System Requirements and Installation
Starting the ProSize Program

Starting the ProSize Program
1 In the Windows Start menu, navigate to ProSize data analysis software.
Alternatively, create a shortcut from your desktop to launch the program.
A splash screen appears showing the software version (Figure 3).

Figure 3

Splash screen displaying version information upon starting the ProSize software (Note:
This manual refers to version 1.0, and higher)

When the software is open, a screen with a white background screen is
displayed. At the upper part of the screen you see two active main menu
options (see Figure 4):

16

•

File > Open File: Use this drop-down menu to open data files. Alternatively,
from the toolbar, select
to open your data.

•

Help > About: Shows information about the software version and Agilent
contact information.

•

Help > Tutorial Videos: Offers a set of tutorial videos on how to use the
software. The other commands of this menu are discussed in detail in
Chapter 3, “ProSize Main Screen”.
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Exit the ProSize software

Figure 4

Main screen of the ProSize software

Exit the ProSize software
To close the ProSize software, select Exit from the File menu, or press
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ProSize Main Screen
Main Screen (No Data File Open) 19
Opening a Data File in ProSize Software 23
Configuration Dialog 25
Main Screen (Data File Open) 27
Plate Map 31
Digital Gel Image Toolbar 33
Electropherogram Trace Toolbar Menu 37
Electropherogram Trace Context Menu 41
Electropherogram Trace Context Menu – RNA Mode 45
Peak Table – DNA Mode 47
Peak Table – NGS Mode 49
Peak Table – gDNA Mode 51
Peak Table – Total RNA Mode 52
Peak Table – mRNA Mode 54
Peak Table – Small RNA Mode 55
Peak Table – Mutation Analysis Mode 56
Flag Analysis Table 57
Smear Analysis Table 59
Advanced Flag Analysis Table 62
Set Individual Parameters 63

This chapter provides an overview of the ProSize software main screen with the
functions and menus available to the user. The file menu for opening and closing
data files is also covered in this chapter.
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ProSize Main Screen
Main Screen (No Data File Open)

Main Screen (No Data File Open)
The functions and menu items available from the main screen of the ProSize
software prior to opening a *.raw data file are summarized in Table 3.

Figure 5

Main screen of ProSize software (no data file open).

Table 3

Main Menu screen menu items (active with no data file open)

Menu Command

Description

File
Open File

Opens a Select folder dialog for locating and opening a raw data file
(*.raw extension) generated by the parallel capillary electrophoresis
instruments for data analysis (Figure 7 ).
Note that if the configuration name (ProSize) and the method name
(FA Software) do not exactly match, the first time a data file is opened
in the ProSize software, the Global Configuration dialog is displayed.
The screen allows you to select the appropriate predefined data
configuration file (*.ini extension), or to customize a configuration file
be selecting the data analysis mode (DNA, RNA, NGS, Mutation
Analysis, gDNA, Restriction Digest) and analysis settings (Figure 9).

Close File

Closes the ProSize software. When closing, the data file, all settings
and operations are automatically saved.
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ProSize Main Screen
Main Screen (No Data File Open)

Table 3

Main Menu screen menu items (active with no data file open)

Menu Command

Description

Administration
Configuration

Opens a pop-up menu with configuration settings. The user can
enable/disable the following settings:
• Login required
• Enhanced security (for more details, refer to Chapter 12, “ProSize
Enhanced Security Features”)
• Auto Logoff Time
• Minimum Password Length
• Password Expiration
• Allowed Login Attempts
• Previous Unique Passwords

Event Report

Opens the Event Log reporting the User ID, Computer Name, Event
Time, Operation, File Path (when relevant), and a Description of the
event.

Option > Option dialog settings

20

Set Default Data Path

Allows you to set the default file path for accessing and saving data
files. In the Select folder dialog, navigate to the desired directory and
select the folder to be set to open data files (Figure 7).
The default directory for opening *.raw data files is
C:\Agilent\Data\.

Language

Allows you to select the language of the program (English, German,
etc.).

Capillary Array Format

Allows you to arrange the data from left to right in the Digital Gel
Image display by Row (A1, A2, A3, etc.) or by Column (A1, B1, C1, etc.).

Display Option

Allows you to select the view of the data by selecting Scale to Sample
or the Autoscale function.

DNA Quality Number (DQN)

Allows you to enable or disable DQN.

Molarity Calculation

Allows you to Use Peak Maxima or Use Avg. Size for all molarity
calculations.

%(Conc.) based on

Allows you to select the preferred concentration units, ng/µL ...
nmole/L, or pg/µL ... pmole/L.

Image Resolution

Define the image resolution as 1X, 2X, 3X, or 4X used for exporting
electropherograms or gel images.

Edit Configuration

Opens the Global Configuration dialog (Figure 9), where you can set
parameters for data analysis mode, peak and marker integration,
quantification, ladder size, etc.

Email

Allows you to set up an email account to send results to.
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ProSize Main Screen
Main Screen (No Data File Open)

Table 3

Main Menu screen menu items (active with no data file open)

Menu Command

Description

Project
Load Project

Opens a Select Folder dialog for locating and opening a Project data
file (*.proj extension) generated for data analysis.

Create Project

Allows you to open the Project screen and create a project by selecting
different *.raw data files.

Batch Processing
Batch Data Process

Allows you to process a set of *.raw files within a selected folder, and
to define an output folder within which processed files are sent.

View Error Log

Allows you to view the error log associated with a particular batch data
process.

Help
User Manuals

Access all ProSize User manuals.

Tutorial Videos

Allows you to open and view a selection of tutorial videos to aid in the
use of the ProSize software.
Alternatively, the tutorial videos can be opened directly from the
C:\ProSize data analysis software\Video directory.

About

Displays software information, version information, copyright
information and Agilent technical support contact information.

The Options pop-up dialog is shown in Figure 6. The properties of the dialog are
described in Table 3 above.
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ProSize Main Screen
Main Screen (No Data File Open)

Figure 6

Option dialog

Figure 7

Set Default Data Path selection screen
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Opening a Data File in ProSize Software

Opening a Data File in ProSize Software
To Open a Data File
1 From the menu, select File > Open File (alternatively, select
toolbar).

from the

The Select Folder dialog opens (Figure 7).
2 Navigate to your raw data file (*.raw extension) for data analysis.
3 Select the folder with the raw data.
In the ProSize software, the Open screen is displayed, showing the selected
file directory (Figure 8).
If you need to navigate to a higher-level directory, select the folder
right of the file path and a standard file browser will open.

to the

4 In the Open screen, click a data file.
A file previewer window will be displayed on the right side of the screen,
containing a digital gel image of the data, a Sample Information list, any typed
Note, and a summary of the experimental Method used to collect the data file
(Figure 8). If the data file has not been previously processed in ProSize, the
heading of the digital gel image will be labeled Non-processed Data. If the data
file has been previously processed, no heading will be displayed on the digital
gel image.
5 If the correct data file is verified, select Open to load the data file into ProSize.
Select Cancel to close the Open screen without loading a file.
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ProSize Main Screen
Opening a Data File in ProSize Software

Figure 8

24

Open file data selection and previewer screen
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Configuration Dialog

Configuration Dialog
Upon selecting Open, the data file will be processed if the matching predefined
data analysis configuration file is available (for example, DNF-473-33 - SS NGS
Fragment 1-6000bp.ini). The first 10 characters of the configuration file name
must match the first 10 characters of the separation method used to
automatically process the data.

NOTE

A minimum of 10 characters must be used to name both the method
(instrument) and configuration (ProSize).
Should there be no matching configuration file, the Global Configuration dialog
will be loaded when opening a previously unprocessed data file. Should the
wrong configuration file be chosen, the user can navigate to the Option window,
and select Edit Configuration to load the correct configuration.
Upon opening, there are ten primary tabs in the Global Configuration dialog
(Figure 9). The settings are discussed in detail in Chapter 4, “ProSize
Configuration”.

Figure 9

Global Configuration dialog (Advanced Settings tab is selected)
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ProSize Main Screen
Configuration Dialog

NOTE

You may create a customized configuration by selecting the proper data analysis
mode (DNA, RNA, etc.) and analysis settings.

NOTE

In most cases, predefined, optimized global configuration files are available to
load for each Agilent Reagent Kit. The configuration files are labeled according to
the particular kit number, for example, DNF-910-33 - DNA 35-1500bp.ini.
After the configuration settings have been loaded, select Apply to open the data
file in the main screen of the ProSize software.

26
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Main Screen (Data File Open)
Once a data file is opened in ProSize, several additional main screen functions
are enabled as summarized in Table 4. The opened data is displayed in the main
screen as shown in Figure 10 (12-capillary data) and Figure 11 (96-capillary
data).
Table 4

Additional Main screen menu items (active only with data file open)

Menu Option

Description

File
Close File

Closes the currently opened data file and displays the main screen. All
settings up to the point of closing the data file will be saved and reloaded
when reopening the data file.

Generate Report
or

Opens a menu for configuring and generating an Adobe .pdf report,
containing user specified information (electropherograms, gel images,
peak information, etc.). For more information, see Chapter 8,
“Generating Reports from ProSize”.

Export Data
or

Opens a menu for configuring and exporting user specified data to a
user specified folder. Types of data include gel images,
electropherograms, peak tables, size calibration data, etc. For more
information, see Chapter 7, “Exporting Data from ProSize”.

Analysis
Show Size Calibration
or

Opens the Calibration Curve screen, which contains input data
associated with the size calibration ladder. For more information, see
Chapter 5, “ProSize Size Calibration Screen”.

Overlay Samples
or

Opens the Overlay Samples screen, where you can overlay gel images
or electropherograms from individual lanes or different data files. For
more information, see Chapter 6, “ProSize Overlay Samples”.

View Capillary Positions

Opens the View Capillary Positions screen, which allows you to view
and modify the alignment of the detector signal with the capillary
positions. For more information, see Chapter 9, “ProSize View Capillary
Positions”.

Quick Display

Displays the Quick Display window, which shows non-normalized
electropherograms for all 12 capillaries (or windows of 12 capillaries
each for a 96-capillary array format) enabling quick review of the data.

Display Separation Parameters

Displays the Separation Parameters window, which allows the user to
view the current, voltage, and pressure that occurred during the
separation.
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Main Screen (Data File Open)

Figure 10

Main screen of ProSize software (12-capillary data file open)
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Figure 11
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Main screen of ProSize software (96-capillary data file open)
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Main Screen (Data File Open)

The primary accessible functions from the main screen are shown in Figure 11,
and are summarized in the legend table:
1

Main screen toolbar

2

Digital Gel image

Digital Gel Image of the data set (see also Figure 14, Table 6). The sample wells are normally
displayed in increasing order for each row. Starting on the left side starting with well A1 (A1, A2,
A3-A12; followed by B1-B12, etc.). Change the view to ascending order of the well columns from left
to right (A1, B1, C1, etc…). From the Option menu, select Capillary Array Format Column. To toggle
back to a row-by-row format, select Capillary Array Format Row.

3

Plate map

Shows the currently selected well highlighted in green (A1 is the default location on opening the file).
Click on the appropriate well by using the keyboard arrows, or double-clicking the appropriate lanes
of the digital gel image. You can select any well of the plate for individual viewing.
The functions available within the Plate Map menu are summarized in Table 5.

4

Info

Click to access experimental information regarding the method used to collect the data file.

5

Sample ID navigation Enables Sample ID navigation. The Sample ID list as entered into the instrument software will be
displayed, enabling you to navigate the samples by Sample ID and to edit sample names if desired.
Close the Sample ID navigation view by right-clicking in the list, and select Close.

6

Contrast

Use the slider bar to change the intensity contrast of the gel image.

7

Re-scale

Re-scale the electropherogram image and gel image by sliding the bar between the two images.

8

Electropherogram
trace

An Electropherogram trace of the currently selected well. The well position and sample name (if
imported) is displayed in the upper left corner of the trace. Right-click the screen to process or
annotate the data (Table 7 and Table 8).

9

Scaling y-axis

Units for the y-axis can be changed by right clicking the axis title and selecting RFU or nmole/L.

10

Scaling x-axis

Units for the x-axis can be changed by right-clicking the axis title and selecting time scale or size
scale.

11

Set individual
parameters

Select
to reveal the configuration window, for which most settings can be individually adjusted
for each sample as desired (see Figure 13). A brief summary of the primary configuration functions
are presented in this section. For more detailed information, refer to Chapter 4, “ProSize
Configuration”.

12

Peak table

Displays information about the selected and integrated sample peaks and markers (see also
Figure 18). Depending on the configurations:
• A Flag Analysis tab will be shown if the flag configuration function contains any flag conditions
(Figure 34).
• A Smear Analysis tab will be shown if the smear analysis configuration contains any entries
(Figure 33).
• An Advanced Flag tab will be displayed if any advanced flag functions are used (Figure 36).

13

Expand
Electropherogram
trace

Select
to expand the Electropherogram trace across the bottom panel which provides you with
more zoom options (see Figure 12).

14

Filename

Upon opening a data file, the currently selected Filename/directory is displayed in the lower left
toolbar.
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Figure 12

Expanded Electropherogram Trace

Figure 13

Main screen with data file open and open configuration dialog (Set Individual Parameters
dialog)
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Plate Map

Plate Map
The functions available within for the Plate Map are summarized in Table 5.
Table 5

Plate Map menu functions

Menu Option

Description

Plate Map

Used to select a sample well for adjusting marker/peak integration,
assigning flag or smear analysis conditions, viewing Peak Table
information and Electropherogram Trace, or adjusting lane contrast in
the Digital Gel Image.
Possibilities to select a well:
• Click the well.
• Change the well selection via the keyboard arrows.
• Double-click the lane in the digital gel image.
• Right-click the sample wells to overlay them in the Electropherogram
section of the screen.
• Select the Sample ID in the Sample ID navigation pane.

To display a well/sample name, place the mouse cursor over the well.

ProSize Data Analysis Software User Manual

31

3

ProSize Main Screen
Plate Map

Table 5

32

Plate Map menu functions

Menu Option

Description

Experimental Information

Shows the instrument system software user interface, containing the
experimental information, Capillary Array information, instrument
system information, and Notes fields for the collected data file.
To close the window, click
.

Sample ID navigation

The Sample ID list will be displayed. In the list, you can navigate the
samples by the Sample ID previously entered into the instrument
system software.
Double-click on a sample name allows you to edit the Sample ID
information.
Right-click the sample ID allows you to Import a .txt file. Select Close to
exit the Sample ID list and return to the plate map view.
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Digital Gel Image Toolbar
The toolbar options above the digital gel image are summarized in Table 6. The
gel image is annotated on both the left and right side with the sample sizing
ladder in bp or nt. The currently selected lane is bracketed by vertical cursors
(Figure 14).
Right-click on any sample lane will overlay the samples in the electropherogram
view. Double-click on a sample lane to view a single sample well in the
electropherogram view.
Additional information is available under Help > Tutorial Videos > ProSize Gel
Image Functions.

Figure 14

Main screen zoomed to the digital gel image and its toolbar menu

Table 6

Digital Gel Image toolbar

Toolbar Option

Description

Copy Full Gel Image

Copies an image of the full Digital Gel Image to the clipboard,
for pasting in another program such as Microsoft PowerPoint.
If zoomed into the gel image, it will copy the visible portion of
the image. The left and right side of the gel image is annotated
with the sizing ladder in the copied gel image.

Copy Selected Gel Lane Image

Copies an image of the currently selected gel lane to the
clipboard, for pasting in another program such as Microsoft
PowerPoint. If zoomed into the gel image, it will copy the
visible portion of the gel lane image. The left side of the gel
lane image is annotated with the sizing ladder in the copied
image.
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Table 6

Digital Gel Image toolbar

Toolbar Option

Description

Show Cursor

Displays a horizontal line cursor across the digital gel image,
annotated by size (bp or nt) corresponding to the current
cursor position. The cursor can be dragged to any position
along the gel image by holding the mouse over the cursor and
pressing and holding the left mouse button.
When the cursor is active and displayed, a similar vertical
cursor annotated by size is displayed in the Electropherogram
Trace, whose movement corresponds to that in the gel image.
Up to four cursors can be displayed at one time.

Hide Cursor

To deactivate the cursor, press the button a second time.

Create Annotation

To create customized annotations in the Digital Gel Image
display. When selected, the Add Annotation window opens.
You can type desired annotation into the field, and select OK.
The annotation will be displayed in the Digital Gel Image
window.

To move the annotation to the desired position on the trace:
Click the annotation and drag it to the desired position. An
arrow will appear at the opposite end of the annotation upon
dragging.
Multiple annotations can be created by repeatedly selecting
Create Annotation. Any created annotations will be copied to
the clipboard with the Copy function.

34
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Table 6

Digital Gel Image toolbar

Toolbar Option

Description

Edit Annotations

Opens the Annotation Editor window. Allows you to:
• Edit the annotation text by typing in the text field.
• Change the color of the annotation by left clicking on the
annotation color.
• Delete one annotation by selecting Delete next to each
annotation, or delete all annotations by selecting Delete All.

Select Apply, to confirm your settings.
Zoom

When selected, zooming to an area by clicking and dragging is
enabled.

AutoFit

Autoscales the Digital Gel Image x-/y-axis view for all 12 or 96
lanes. The autoscaled image will display the gel from the
selected lower marker to upper marker, or if only a lower
marker only is used from the lower marker to the end of the
separation window.

Auto Intensity

Autoscales the intensity of the Digital Gel Image view for all 12
or 96 lanes. The viewed intensity across the image will reflect
the actual observed fluorescence signals from each lane.

Normalize Intensity to Lower Marker

Normalizes the intensity of the Digital Gel Image view for the
lower marker to the same value for all 12 or 96 lanes, adjusting
the relative intensities of all bands in each lane accordingly.
The viewed intensity across the image will as a result reflect
the fluorescence signals from each lane after normalization to
the lower marker, as is done when calculating the
concentration of samples using the lower marker.

Normalize Intensity to Upper Marker

Normalizes the intensity of the Digital Gel Image view for the
upper marker to the same value for all 12 or 96 lanes,
adjusting the relative intensities of all bands in each lane
accordingly. The viewed intensity across the image will as a
result reflect the fluorescence signals from each lane after
normalization to the upper marker, as is done when
calculating the concentration of samples using the upper
marker.
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Table 6
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Digital Gel Image toolbar

Toolbar Option

Description

Enhanced Contrast

Increases the contrast of an individual lane while holding other
lanes constant. When selected, the Lane Contrast Control
window opens. Drag the scroll bar to adjust the contrast for
the currently selected lane in the gel image. Once adjusted,
click OK to accept changes, or select Cancel to discard your
changes.
Note: The enhanced contrast setting works on the currently
selected lane only (marked with vertical cursors in gel image).
The Auto Intensity, Normalize Intensity to Lower Marker, and
Normalize Intensity to Upper Marker functions will undo any
previous enhanced contrast operations.

Gel Image Color

Changes the color scheme for the Digital Gel View, the gel
image in the Overlay Samples screen and any exported or
printed report.
Options for the gel image color:
• White on Black (white bands on black background)
• Black on White (black bands on white background)
• Green on Black (green bands on black background)
• Red on Black (red bands on black background)
• Pseudo Color (green to red bands on blue background)

1:1 Gel Image

Displays the gel image in an adjustable window for changing
the aspect ratio of the gel image (useful for producing figures
for papers). The adjusted image can be copied to the
clipboard.

Hide/Show Marker Peaks

Toggle to hide or show the marker peaks in the digital gel
image screen. This is useful when comparing to a slab gel
result which does not use lower/upper normalization markers.

Hide/Show non-integrated peaks

Toggle to hide or show non-integrated peaks in the digital gel
image screen. This is useful for eliminating noise peaks from
the gel image.

Gaussian Fit

Toggle to fit all peaks to a narrow Gaussian peak.
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Electropherogram Trace Toolbar Menu
The options available in the Electropherogram Trace toolbar are summarized in
Table 7.
Additional information is available under Help > Tutorial Videos > ProSize
Electropherogram Functions.

Figure 15

NOTE

Main screen zoomed to the Electropherogram Trace and its toolbar menu. Note the y-axis
scale is set to the sample peaks and not the marker peak heights.

In version 4.0 of the ProSize software, the Electropherogram Trace will
automatically autoscale to the largest observed sample peak, regardless of the
lower/upper marker peak heights. To view the entire y-axis scale including
marker peaks, in the Option window, select Autoscale as the Display Option (see
Figure 6).
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Table 7
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Electropherogram Trace toolbar functions

Toolbar Option

Description

Zoom

Enables zooming in the x- and y-axis of the Electropherogram Trace.
To zoom-in: Place the mouse over the trace, click and drag it outward to
expand a box area to define the zoom region. Release the mouse
button to apply. The zoomed image can be copied to the clipboard. The
zoom region will be preserved when viewing other samples in the Plate
Map.
To undo the zoom, use the Autoscale function.

Pan

Enables panning of the image. Move the image around with the mouse
cursor.

Autoscale

To autoscale the Electropherogram Trace x-/y-axis display. The
autoscaled image will display the full trace from the start to the end of
the separation when using the Time Scale and Size Scale display
modes; when using the Uniform Size Scale the autoscaled display will
start at 0 bp.
Note: the y-axis scale will automatically zoom to the highest detected
sample peak, regardless of the marker peak heights. To view the entire
y-axis scale including markers, go to Option window, and as Display
Option, select Autoscale.

Copy

Copies an image of the current view of the Electropherogram Trace to
the clipboard, for pasting in another program such as Microsoft
PowerPoint. Any zoom, annotation, baseline and/or peak start/end
point displayed will be copied in the image. The well ID and sample
name will be copied in the top left of the trace, and the x-/y-axis will
correspond to the currently selected view in the copied image.

Units

Displays a menu for changing the peak annotation of the
Electropherogram Trace. Only integrated peaks are annotated.
Units for the peak annotation:
• None
• Peak ID (labels in order as 1, 2, etc.)
• Migration Time (min:sec) raw migration time
• Peak Height (in RFUs)
• Corrected Peak Area (Peak Area/Migration Time)
• Size (in bp or nt)
• Average Size (in bp or nt)
• Concentration (in ng/µL)
• nmole/L
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Table 7

Electropherogram Trace toolbar functions

Toolbar Option

Description

Create Annotation

To create customized annotation in the Electropherogram Trace
display. In the Add Annotation dialog, the user can type desired
annotation into the field. Click OK and the annotation will be displayed
in the Electropherogram Trace window.

To move the annotation to the desired position on the trace: Click the
annotation and drag it to the desired position. An arrow will appear at
the opposite end of the annotation upon dragging.
Multiple annotations can be created by repeatedly selecting Create
Annotation. Any created annotations will be copied to the clipboard
with the Copy function.
Edit Annotations

Opens the Annotation Editor window. Allows the user to:
• Edit the annotation text by typing in the text field.
• Change the color of the annotation by left clicking on the annotation
color.
• Delete one annotation by selecting Delete next to each annotation,
or delete all annotations by selecting Delete All.

Select Apply to confirm your settings.
Show/Hide Baseline

Toggle to display or hide the baseline drawn for the peak integration,
shown as an orange line. Displaying the baseline helps if adjustments
need to be made to the baseline to better define the actual peak area
via the Peak Width (sec), Valley to Valley, or Manual Baseline
Setpoints tools.
Note: It is highly recommended to enable the display of the baseline, to
ensure the correct baseline is being drawn to the data, especially with
DNA/RNA smears.
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Table 7
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Electropherogram Trace toolbar functions

Toolbar Option

Description

Show Peak Start/End Edge

Toggle to diplay or hide the start and end points used for peak
integration, shown as vertical orange lines.
Displaying the peak integration start/end points helps if adjustments
need to be made to the peak integration to better define the actual peak
area.
The user can change the peak start/end points by adjusting the Peak
Width (sec), or by using the right click menu tools in the
Electropherogram Trace such as Split Peak or Move Peak Start/End
Points (see Table 8).
The user can change the baseline drawn (and subsequently the peak
start/end points) via the Peak Width (sec), Valley to Valley, or Manual
Baseline Setpoints tools.
Note: It is highly recommended to enable the display of the baseline, to
ensure the correct integration is being drawn to each peak, especially
with DNA/RNA smears.

Expand Electropherogram Trace

Expands the Electropherogram Trace across the bottom panel
covering the Peak Table. Provides more user control over zoom.
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Electropherogram Trace Context Menu
The context menu of the trace, the y-axis, and the x-axis contains functions for
adjusting marker peak assignment, peak integration and scaling the x-axis of the
Electropherogram Trace (Figure 16). Functions are also provided for copying the
trace and exporting the data, and are summarized in Table 8.
Additional information is available under Help > Tutorial Videos > ProSize
Electropherogram Functions.

Figure 16

Main screen zoomed to the Electropherogram Trace and context menus. Note that the y-axis
scale is set to the sample peaks and not the marker peak heights.

Table 8

Electropherogram Trace context menu commands

Menu commands

Description

Accept Change

Accepts any manual modification to the performed peak integration (Add
Peak, Split Peak, Merge Peaks, Delete Peak, Move Peak Start/End
Points). After the manual modification has been made, select Accept
Change to apply the changes to the trace.

Cancel

Cancels any manual modification to the peak integration (Add Peak, Split
Peak, Merge Peaks, Delete Peak, Move Peak Start/End Points). Select
Cancel to discard the changes applied to the trace.

Undo

To undo any manual modification applied to the peak integration (Add
Peak, Split Peak, Merge Peaks, Delete Peak, Move Peak Start/End
Points). Select Undo to revert back one step.

Set As Lower Marker/
Set As Upper Marker

To automatically set any integrated peak to the lower or upper marker,
and correspondingly re-normalize the trace to the new marker.
Right-click the peak to be reassigned as the marker. Select Set As Upper
(or Lower) Marker. The peak will be set as the marker and renormalized.
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Table 8
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Electropherogram Trace context menu commands

Menu commands

Description

Add Peak

To manually add a peak which has not been auto-integrated by the Peak
Analysis settings and to define the start and end point for integration.
Zoom-in to the region where the peak is to be added. Right-click this
region and select Add Peak. Two red vertical cursors will appear; the left
cursor defines the new peak start point and the right cursor the new peak
end point. Drag each cursor to the desired position, then right-click, and
select Accept Change to add the peak for integration.
Note: The Add Peak function will not add a peak that is located outside the
lower/upper marker window (or before lower marker if using only lower
marker).

Split Peak

To manually split a peak which is currently integrated into two peaks and
to define where the split occurs.
Zoom-in to the region where the peak is to be split. Right-click this region,
and select Split Peak. A red vertical cursor will appear. Drag the cursor to
the desired location, then right-click, and select Accept Change to split the
peak into two peaks for integration.

Merge Peaks

To merge any number of peaks and integrate as a single peak.
Zoom-in to the region where the peak is to be split. Right-click this region,
and select Merge Peaks. Two red vertical cursors will appear; the left
cursor defines the left most peak to merge and right cursor defines the
right most peak to merge. Drag the cursor within that peak’s start/end
point region to merge, then right click, and select Accept Change to
merge the peaks into a single peak for integration.

Delete Peak

To manually delete a peak which has been integrated.
Zoom-in to the region where the peak is to be deleted. Right-click this
region, and select Delete Peak. A red vertical cursor will appear. Drag the
cursor to the desired peak location, then right-click, and select Accept
Change to delete the peak from the integration.

Move Peak Start/End Points

To change the currently positioned start/end integration points of a peak.
Zoom-in to the region where the peak is located. Place the cursor
between the start and end points of the integration. Right-click and select
Move Peak Start/End Points. Two red vertical cursors will appear at the
current start/end points. Drag the cursors to the desired locations, then
right-click and select Accept Change to apply the new start/end point
positions to reintegrate the peak.
Note: This function will not change the baseline; only the start and end
points are affected. To change the baseline, the user must adjust the via
the Peak Width (sec), Valley to Valley, or Manual Baseline Setpoints
tools.
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Table 8

Electropherogram Trace context menu commands

Menu commands

Description

Copy Image to Clipboard

Copies an image of the current view of the Electropherogram Trace to the
clipboard, for pasting in another program, such as Microsoft PowerPoint.
Any zoom, annotation, baseline and/or peak start/end point displayed will
be copied in the image. The well ID and sample name will be copied in the
top left of the trace, and the x-/y-axis will correspond to the currently
selected view in the copied image.

Export Data to Clipboard

Copies the electropherogram x-data (time; in seconds) and y-data
(RFUs) in a .csv format that can be pasted directly into common
spreadsheet programs such as Microsoft Excel. The x-data is copied into
column 1, and the y-data into column 2 of the file upon pasting.
To export, right-click and select Export Data to Clipboard. Open a
spreadsheet, select the desired cell and paste the copied data.
Note: In the Time Scale and Size Scale display modes, the exported data
will be:
• x = time, and
• y = RFU.

Export Data to Excel

This function requires Microsoft Excel to be installed on the computer to
function properly. Selection will automatically open Microsoft Excel and
copy the electropherogram x (time; in seconds) and y (RFUs) in a .csv
format. The x-data is copied into column 1, and the y-data into column 2
of the file upon pasting.
To export, right-click and select Export Data to Excel. The file can then be
processed and saved as desired.
Note: In the Time Scale and Size Scale display modes, the exported data
will be:
• x = time, and
• y = RFU.

Time Scale

Changes the x-axis to units of migration time in hours, minutes and
seconds (HH:MM:SS).
To change, right-click and select Time Scale. The x-axis scale will change
to time and the trace with autoscale.

Size (bp) Scale

Changes the x-axis to units of size (bp in DNA, NGS, gDNA, Mutation
Analysis or Restriction Digest modes; nt in RNA modes). The display will
use underlying units of time and convert the time to size from the current
Size Calibration settings.
To change, right-click and select Size Scale. The x-axis scale will change
to a size scale and the trace with autoscale.
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Electropherogram Trace context menu commands

Menu commands

Description

Set Display Starting Time
(min)

To set-up the displayed start time at the x-axis.
Right-click the x-axis and select Set Display Starting Time (min). In the
dialog, enter a start time (in minutes), and select Apply to confirm your
entry.

Set nmol/L

To set-up the scaling for the y-axis. Allows you to change the scale from
RFU to nmol/L.
To change, right-click the y-axis, and select Set nmol/L.
To change the y-axis scale back to RFU, right-click the y-axis, and select
RFU.
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Electropherogram Trace Context Menu – RNA Mode
In RNA (Eukaryotic), RNA (Prokaryotic), or RNA (Plant) analysis modes, additional
commands are shown in the Electropherogram Trace context menu (see
Figure 17 and Table 9).

NOTE

The currently selected 16S/18S ribosomal RNA peak is highlighted pink, and the
currently selected 23S/25S/28S ribosomal RNA peak is highlighted blue in the
Electropherogram Trace when in these RNA analysis modes.

Figure 17

Zoomed-in Electropherogram Trace screen showing context menu in RNA (Eukaryotic) mode.
Note that the ribosomal RNA peaks are shaded pink and blue, respectively.

Table 9

Electropherogram Trace context menu commands (only available in RNA mode)

Menu commands

Description

RNA (Eukaryotic) Mode
Set As 18S

To manually assign a peak as the 18S ribosomal RNA peak for
calculating the sample’s RNA Quality Number (RQN).
Place the mouse over the peak to be reassigned as the 18S peak.
Right-click and select Set As 18S. The peak will be set as the 18S peak
and the RQN recalculated.
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Table 9

Electropherogram Trace context menu commands (only available in RNA mode)

Menu commands

Description

Set As 28S

To manually assign a peak as the 28S ribosomal RNA peak for
calculating the sample’s RNA Quality Number (RQN).
Place the mouse over the peak to be reassigned as the 28S peak.
Right-click and select Set As 28S. The peak will be set as the 28S peak
and the RQN recalculated.

RNA (Prokaryotic) Mode
Set As 16S

To manually assign a peak as the 16S ribosomal RNA peak for
calculating the sample’s RNA Quality Number (RQN).
Place the mouse over the peak to be reassigned as the 16S peak.
Right-click and select Set As 16S. The peak will be set as the 16S peak
and the RQN recalculated.

Set As 23S

To manually assign a peak as the 23S ribosomal RNA peak for
calculating the sample’s RNA Quality Number (RQN).
Place the mouse over the peak to be reassigned as the 23S peak.
Right-click and left click Set As 23S. The peak will be set as the 23S
peak and the RQN recalculated.

RNA (Plant) Mode

46

Set As 18S

To manually assign a peak as the 18S ribosomal RNA peak for
calculating the sample’s RNA Quality Number (RQN).
Place the mouse over the peak to be reassigned as the 18S peak.
Right-click and select Set As 18S. The peak will be set as the 18S peak
and the RQN recalculated.

Set As 25S

To manually assign a peak as the 25S ribosomal RNA peak for
calculating the sample’s RNA Quality Number (RQN).
Place the mouse over the peak to be reassigned as the 25S peak.
Right-click and select Set As 25S. The peak will be set as the 25S peak
and the RQN recalculated.
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Peak Table – DNA Mode
The Peak Table displays information about the selected and integrated sample
peaks and markers (Figure 18). The data in this table can be directly exported via
its context menu. The fields of the Peak Table are summarized in Table 10.

NOTE

When the Show Marker Information on Peak Table setting is selected (Global
Configuration dialog > Advanced Settings tab), entries for the lower and/or upper
marker will also be visible in the table.

Figure 18

Peak Table form on main screen (DNA mode)

Table 10

Peak Table functions (only available in DNA mode)

Item

Description

Size

Reports the calculated size in bp (DNA, NGS, Mutation Analysis, gDNA,
Restriction Digest modes) or nt (RNA modes) for each integrated peak.

Conc. (ng/µL)

Reports the calculated concentration in units of nanogram per microliter (ng/µL)
for each integrated peak. The concentration is calculated from comparison to
the lower or upper marker, or to the calibration sizing ladder referenced to the
lower marker depending upon the current settings in the Quantification tab of
the Global configuration dialog. Any factoring from dilution of the input sample
is also calculated via the Quantification settings.

% (Conc.)

Reports the calculated % of total concentration (not including markers) for each
integrated peak in the sample.
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Table 10
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Peak Table functions (only available in DNA mode)

Item

Description

nmole/L

Reports the calculated concentration in units of nanomoles per liter (nmole/L)
for each integrated peak. The concentration is calculated from comparison to
the lower or upper marker, or to the calibration sizing ladder referenced to the
lower marker depending upon the current settings in the Quantification tab of
the Global configuration dialog. Any factoring from dilution of the input sample
is also calculated via the Quantification settings.
Note: This calculation is only approximate for smear peaks, as the molecular
weight of the DNA/RNA fragments constituting the smear is a mixture of many
different length species.

TIC

Reports Total Integrated Concentration (TIC), in ng/µL of all integrated peaks for
the sample (not including markers).
Note: The TIC does not factor in the concentration for peaks or smears that are
not integrated in the sample result.

TIM

Reports Total Integrated Molarity (TIM), in nmole/L of all integrated peaks for the
sample (not including markers).
Note: The TIM does not factor in the molarity for peaks or smears that are not
integrated in the sample result.

Total Conc.:

Reports the calculated total concentration in ng/µL of all peaks for the sample
(not including markers), regardless of whether the peaks are integrated or not.
Note: The Total Conc. takes into account all of the total peak area above the
baseline after the lower marker when using the lower marker only for
normalization, or the total peak area above the baseline and between the lower
and upper markers when using both markers for normalization. The Total Conc.
does not include peak area below the lower marker or after the upper marker.

DQN

Reports the DNA Quality Number, which is a percent/10 of DNA above a
user-defined threshold (defined in Global Configuration dialog > Advanced
Settings tab).

Export Data to
Clipboard

Right-click in the table and select Export Data to Clipboard. The peak table
information is exported to the clipboard for pasting directly into common
spreadsheet programs such as Microsoft Excel. The full table is exported.
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Peak Table – NGS Mode
In NGS analysis mode, additional information about selected peaks and/or
smears is displayed in the Peak Table (Figure 19 and Table 11).
This additional information is useful when examining DNA smear characteristics
for NGS applications.

Figure 19

Peak Table form on main screen (NGS mode).

Table 11

Additional Peak Table functions (only available in NGS mode)

Item

Description

From (bp)

Reports the size (in bp) of the starting integration point of a DNA peak/smear
(i.e., minimum size value).

To (bp)

Reports the size (in bp) of the ending integration point of a DNA peak/smear (i.e.,
maximum size value).

Avg. Size

Reports the mean size (in bp) of the integrated DNA peak/smear, accounting for
the distribution of the concentration of the peak/smear. Therefore, the Avg. Size
will reflect the size corresponding to 50% of the total peak/smear concentration
being below and above this value.
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Table 11
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Additional Peak Table functions (only available in NGS mode)

Item

Description

CV%

Reports the distribution of concentration from the mean for a peak/smear, in
terms of the coefficient of variation (CV), where CV is the ratio of the standard
deviation (σ) to the mean (μ):
CV(%) = σ / μ
The value is reported as a percentage; smaller values indicate a tighter size
distribution of the integrated peak/smear concentration.

DQN

Reports the DNA Quality Number, which is a percent/10 of DNA above a
user-defined threshold (defined in Global Configuration dialog > Advanced
Settings tab).
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Peak Table – gDNA Mode
In the gDNA analysis mode, additional information about the selected peaks
and/or smears is displayed in the Peak Table (Figure 20 and Table 12).
This additional information is useful when examining genomic DNA.

Figure 20

Peak Table form on main screen when in gDNA mode

Table 12

Additional Peak Table functions (only in gDNA mode)

Item

Description

GQN

Reports the sample’s calculated Genomic Quality Number (GQN). This value is
based upon the concentration of sample above and below the User defined Size
Threshold (bp) and is based on a scale of 1 (poorest) to 10 (highest). GQN is
reflected as percent/10 above the user-defined threshold (defined in Global
Configuration dialog > Advanced Settings tab).

Threshold

The user defined size (bp) used in the calculation of GQN.
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Peak Table – Total RNA Mode
In the RNA (Eukaryotic), RNA (Prokaryotic), or RNA (Plant) analysis modes,
additional information is displayed to the right of the Peak Table (Figure 21 and
Table 13).
This additional information is useful for examining RNA sample characteristics
and for calculating a sample’s RQN (RNA Quality Number).

52

Figure 21

Peak Table form on main screen when in RNA modes

Table 13

Additional Peak Table functions (only available in RNA mode)

Item

Description

RNA Concentration (ng/µL)

Reports the calculated total concentration in ng/µL of all peaks for the
sample (not including the markers), regardless of whether the peaks
are integrated or not.
Note: The RNA concentration takes into account all of the total peak
area above the baseline after the lower marker when using the lower
marker only for normalization. The RNA concentration does not
include peak area below the lower marker.
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Table 13

Additional Peak Table functions (only available in RNA mode)

Item

Description

28S/18S (Eukaryotic), or
23S/16S (Prokaryotic), or
25S/18S (Plant)

Reports the calculated concentration ratio of the selected ribosomal
RNA peaks. This ratio is an indication of the quality of the RNA
sample and is used in calculating the sample’s RNA Quality Number
(RQN).

RNA Quality Number

Reports the sample’s calculated RNA Quality Number (RQN). This
value is based upon several factors including sample concentration,
ribosomal RNA peak ratios and sample purity, and is based on a scale
of 1 (poorest) to 10 (highest).
Note: If the ribosomal peaks are not detected or fall below a threshold
concentration level, NaN will be displayed and no RQN value will be
reported.

ProSize Data Analysis Software User Manual

53

3

ProSize Main Screen
Peak Table – mRNA Mode

Peak Table – mRNA Mode
In the mRNA analysis mode, additional information is displayed to the right of the
Peak Table (Figure 22 and Table 14).
This additional information is useful for examining RNA sample characteristics
and for calculating a sample’s % rRNA contamination.
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Figure 22

Peak Table form on main screen when in mRNA mode

Table 14

Additional Peak Table functions (only available in mRNA mode)

Item

Description

% rRNA Contamination

Reports the calculated ribosomal RNA
contamination in the sample (not including the
markers), regardless of whether the peaks are
integrated or not.
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Peak Table – Small RNA Mode
In the Small RNA analysis mode, additional information is displayed to the right
of the Peak Table (Figure 23 and Table 15).
This additional information is useful for examining Small RNA sample
characteristics and for calculating a sample’s % micro RNA.

Figure 23

Peak Table on main screen when in small RNA mode

Table 15

Additional Peak Table functions (only available in small RNA mode)

Item

Description

%microRNA

Reports the sample’s calculated %microRNA within
the small RNA defined region. This value is based
upon several factors including sample concentration,
Maximum miRNA (nt), and Maximum Small RNA (nt).
Default setpoint is 4 nt but can be changed by the
user.

smallRNA (pg/µL)

Reports the concentration from the Lower Marker to
the Maximum Small RNA (nt) setpoint. Defualt
setpoint is 40 nt but can be changed by the user.

microRNA (pg/µL)

Reports the concentration from the Lower Marker to
the Maximum miRNA (nt) setpoint. Default setpoint is
300 nt but can be changed by the user.
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Peak Table – Mutation Analysis Mode
In the Mutation Analysis mode, if the combined size of a pair of integrated DNA
peaks adds up to the size of the largest integrated DNA peak (assumed to be the
intact gene), within the % Error defined in the Advanced Settings tab of the Global
Configuration dialog, those peaks are highlighted in both the Electropherogram
Trace and Peak Table (Figure 24).

Figure 24

NOTE
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Electropherogram Trace and Peak Table highlighted for positive result in Mutation Analysis
mode (combined size within preset % Error of 15%)

In order for peaks indicating a positive result in the Mutation Analysis mode to be
highlighted in the Electropherogram Trace and Peak Table, the Valley to Valley
Baseline? setting must be enabled in both the Peak Analysis and Marker Analysis
tabs of the Global Configuration dialog.
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Flag Analysis Table
If the configuration contains any Flag settings, a Flag Analysis tab will also be
visible as a separate tab with the Peak Table (Figure 25 and Table 16). The
flagged results are displayed in rows, with each row corresponding to a sample
well of the plate. The columns are titled by the flag tag which is the field used to
name the particular flag condition. The results are output in a binary format with
0 = FALSE and 1 = TRUE.

NOTE

The information in the Flag Analysis tab can be exported to the clipboard for
pasting into common spreadsheet programs by right clicking the mouse and left
clicking Export Data to Clipboard. Further information on the flag functions can be
found in Chapter 4, “ProSize Configuration” or under Help > Tutorial Videos > Flag
Analysis.

Figure 25

Flag Analysis tab on main screen

Table 16

Flag Analysis tab

Item

Description

Well/Sample Name

The first column labels the sample well; the second Sample ID
column lists the entered sample name.

Columns

Each column is titled by the respective tag entry and flag conditions
for each entry.
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Table 16

58

Flag Analysis tab

Item

Description

Column/Row Data

Data is reported in binary format, following the specified criteria for
each flag condition:
0 = FALSE (conditions not met)
1 = TRUE (conditions met)

Export Data to Clipboard

From the context menu of the table, select Export Data to Clipboard.
The peak table information is exported to the clipboard for pasting
directly into common spreadsheet programs such as Microsoft
Excel. The full table is exported.
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Smear Analysis Table
If the configuration of the Smear Analysis tab contains any filter settings, a Smear
Analysis tab will also be visible as a separate tab with the Peak Table (Figure 26
and Table 17).
The calculated results table shows for each sample row the following columns
(for details, see Table 17):
•

the sample ID and well position

•

the customized smear size Range

•

the calculated concentration in ng/µL for the defined size range

•

the % Total, which is the percent of total sample concentration in the smear
range

•

the nmole/L concentration of the defined smear range

•

the Avg. Size

•

%CV of the defined smear range

Smear Analysis ranges are color coded and a vertical dotted line will show on the
electropherogram view showing the range and reporting the corresponding
average size for the smears (see Figure 27).
If a sample well has not been selected for the Smear Analysis, its row will be left
blank. If multiple size ranges are selected for a sample, multiple rows will be
displayed. In Figure 26, all wells have two smear ranges selected: 190 bp to
500 bp, and 500 bp to 900 bp.

NOTE

The information in the Smear Analysis tab can be exported to the clipboard for
pasting into common spreadsheet programs. Select Export Data to Clipboard
from the context menu. Further information on the flag functions are discussed
in Chapter 3, “ProSize Main Screen” or in the Help > Tutorial Videos > Smear
Analysis.
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Figure 26

Smear Analysis tab on main screen

Figure 27

Electropherogram view when Smear Analysis tab selected on main screen

Table 17

Smear Analysis tab

Item

Description

ID

Lists the Sample Well: Sample Name.

Range

Lists the smear range, in size (bp).
The smear range corresponds to the Start Size and End Size entered in
the Smear Analysis tab (Global Configuration dialog).
Note: If the Apply function has not been made to the respective well, it
will be blank in the table.
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Table 17

Smear Analysis tab

Item

Description

ng/µL

Reports the concentration of the defined smear range in ng/µL.

% Total

Reports the % of the total concentration of the sample that resides in the
defined smear range.

nmole/L

Reports in alternate concentration units of nmole/L for the defined
smear range.

Average Size

Reports the mean size (in bp) of the defined smear range, accounting for
the distribution of the concentration of the smear. Therefore, the Avg.
Size will reflect the size corresponding to 50% of the total smear
concentration being below and above this value.

% CV

Reports the distribution of concentration from the mean for the defined
smear, in terms of the coefficient of variation (CV), where CV is the ratio
of the standard deviation (σ) to the mean (μ):
CV(%) = σ / μ
The value is reported as a percentage; smaller values indicate a tighter
size distribution of the smear concentration.

Export Data to Clipboard

From the context menu of the table, select Export Data to Clipboard.
The peak table information is exported to the clipboard for pasting
directly into common spreadsheet programs such as Microsoft Excel.
The full table is exported.
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Advanced Flag Analysis Table
The Advanced Flag tab of the Global Configuration dialog offers flag settings. An
Advanced Flag Analysis tab will be displayed as a separate tab with the Peak
Table (Figure 28). The flagged results are displayed, with each page representing
a single well.
The Advanced Flag Analysis tab reports the following results columns:
•

size concentration

•

% Concentration

•

nmole/L

•

RFU

To see results for all wells simultaneously, export the data to a .csv file using the
Export button in the main menu.
Further information on the flag functions can be found in Chapter 4, “ProSize
Configuration” or under Help > Tutorial Videos > Advanced Flag Analysis.

Figure 28
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Advanced Flag Analysis tab on main screen
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Set Individual Parameters
When a data file is initially loaded into the ProSize software, the settings for
selection of lower/upper markers, sample peak integration, size calibration,
quantification, and any flag/smear analysis are globally set for all samples in the
Global Configuration dialog (for more information, see Chapter 4, “ProSize
Configuration”).
After the data is loaded, any of the common configuration parameters can be
individually edited for each sample independently (local setting), or changes can
be made and applied to all samples (global setting), or to a customized subset of
samples.
To view and adjust the configuration settings for the currently viewed
lane/sample, select
Set Individual Parameters on the right side of the Peak
Table. This will reveal the configuration dialog, for which most settings can be
individually adjusted for each sample as desired (Figure 29). To toggle back to
the Peak Table, select
Show Results.

Figure 29

Main screen with data file open and configuration dialog open (clicked)
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The individual settings within each tab are described in detail in Chapter 4,
“ProSize Configuration”. The following sections describe the settings that apply
to individual configuration tabs.

Configuration – Peak Analysis
The Peak Analysis tab contains settings to define the sample peak integration,
data analysis filter, analysis region, and manual baseline set points (Figure 30).
These functions are described in detail in section “Global Configuration - Peak
Analysis” on page 84.
New settings in the Peak Analysis tab are applied to the current selected sample
well only, or to all samples of the sample plate (see Table 18).

Figure 30
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Peak Analysis tab in Set Individual Parameters dialog
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Table 18

Additional Peak Analysis settings

Setting

Description

Apply to All

All current settings of the Peak Analysis tab will be applied to all samples of
the loaded data file. This is therefore a global function.
Note: Any previous individually tuned Peak Analysis tab settings for
different samples of the data file will be overwritten when using this
function.

Apply to Selected

All current settings of the Peak Analysis tab will be applied to the specified
wells of the sample plate. Upon selecting this function, the Selected
Samples plate map menu will be displayed to select the wells of the sample
plate to apply the current settings to.

Click the desired wells, rows or columns, and click OK to apply; click Cancel
to abort the operation.
Note: Any previous individual setting of the Peak Analysis tab for the
selected samples of the data file will be overwritten when using this
function.
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Configuration – Marker Analysis
The Marker Analysis tab contains settings to define the marker peak selection
and marker peak integration (Figure 31). These settings are described in detail in
“Global Configuration - Marker Analysis” on page 89.
New settings in the Marker Analysis tab can be applied to the current selected
sample well only, or to all samples of the sample plate (see Table 19).

Figure 31
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Marker Analysis tab Set Individual Parameters dialog
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Table 19

Additional Marker Analysis settings

Setting

Description

Apply to All

All current settings of the Marker Analysis tab will be applied to all
samples of the loaded data file. This is therefore a global function.
Note: Any previous individually tuned Marker Analysis tab settings for
different samples of the data file will be overwritten when using this
function.

Apply to Selected

All current settings of the Marker Analysis tab will be applied to the
specified wells of the sample plate. Upon selecting this function, the
Selected Samples plate map menu will be displayed to select the wells of
the sample plate to apply the current settings to.

Select the desired wells, rows or columns, and click OK to apply; click
Cancel to abort the operation.
Note: Any previous individual setting of the Marker Analysis tab for the
selected samples of the data file will be overwritten when using this
function.

ProSize Data Analysis Software User Manual

67

3

ProSize Main Screen
Set Individual Parameters

Configuration – Quantification
The Quantification tab contains settings to assign a marker or ladder for
quantification; its working concentration and any dilution factor applied to the
sample prior to injection (Figure 32). These functions are described in detail in
“Global Configuration - Quantification” on page 96.
New settings in the Quantification tab are applied to the current selected sample
well only, or to all samples of the sample plate (see Table 20).

Figure 32
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Quantification tab in Set Individual Parameters dialog
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Table 20

Additional Quantification settings

Setting

Description

Apply to All

All current settings of the Quantification tab will be applied to all
samples of the loaded data file. This is therefore a global function.
Note: Any previous individually tuned Quantification tab settings
for different samples of the data file will be overwritten when using
this function.

Apply to Selected

All current settings of the Quantification tab will be applied to the
specified wells of the sample plate. Upon selecting this function,
the Selected Samples plate map menu will be displayed to select
the wells of the sample plate to apply the current settings to.

Select the desired wells, rows or columns, and click OK to apply;
click Cancel to abort the operation.
Note: Any previous individual setting of the Quantification tab for
the selected samples of the data file will be overwritten when
using this function.
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Configuration – Smear Analysis
The Smear Analysis tab contains settings to enable the user to specify a size
range(s) for which to integrate and calculate the total concentration in ng/mL
(Figure 33). These functions are described in detail in “Global Configuration Smear Analysis” on page 99
New settings in the Smear Analysis tab are applied to the current selected sample
well only, or to all samples of the sample plate (see Table 21).

NOTE

If Display Smear Range is enabled, two color coded vertical dotted cursors are
displayed in the Electropherogram Trace screen. These cursors define the
entered values for the Start Size (bp) and the End Size (bp) for the currently
selected smear range. The colors can be changed by left clicking on the color
next to the smear range. The start and end points of the smear range can be
adjusted by clicking on a cursor peak, and dragging the respective cursor left or
right; the smear analysis region will be automatically updated to the new cursor
location.

Figure 33
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Smear Analysis tab in Set Individual Parameters dialog with Display Smear Range enabled
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Table 21

Additional Smear Analysis settings

Setting

Description

Apply to All

All current settings of the Smear Analysis tab will be applied to
all samples of the loaded data file. This is therefore a global
function.
Note: Any previous individually tuned Smear Analysis tab
settings for different samples of the data file will be overwritten
when using this function.

Apply to Selected

All current settings of the Smear Analysis tab will be applied to
the specified wells of the sample plate. Upon selecting this
function, the Selected Samples plate map menu will be
displayed to select the wells of the sample plate to apply the
current settings to.

Select the desired wells, rows or columns, and click OK to apply;
click Cancel to abort the operation.
Note: Any previous individual settings of the Smear Analysis tab
for the selected samples of the data file will be overwritten when
using this function.
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Configuration – Flag Analysis
The Flag Analysis tab contains settings to enable the user to specify specific
criteria (size or concentration range) to be met within the data, and generate a
binary output (0 = false, 1 = true) of the results (Figure 34). These settings are
described in detail in “Global Configuration - Flag” on page 101.
New settings in the Flag Analysis tab are applied to all samples of the sample
plate. Some of these settings are described in Table 22.
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Figure 34

Flag Analysis tab in Set Individual Parameters dialog

Table 22

Additional Flag Analysis settings

Setting

Description

Save Flag Parameters

The current Flag Analysis settings will be saved as a file
(*.Flag extension) that can be loaded into different data files.
A file browser menu will open to navigate and save the
desired filename and location; click OK to save the file, or
Cancel to discard your changes.

Load Flag Parameters

The previously saved Flag Analysis settings will be loaded
from a file (*.Flag extension). A file browser menu will open
to navigate and load the desired filename and location; click
OK to load the file, or Cancel to discard your changes.

Remove All Flag Parameters

All settings will be cleared from the tab.
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Configuration – Advanced Settings
The Advanced Settings tab contains settings to assign the data analysis mode for
processing data (Figure 35). All settings of this tab are described in detail in
“Global Configuration – Advanced Flag” on page 102.

NOTE

The Advanced Settings parameters are applied to all samples in the data file.
Individual samples cannot use different analysis modes. It is assumed all data is
processed with a single analysis mode in a single experiment or data file.

Figure 35

Advanced Settings tab in Set Individual Parameters dialog
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Configuration – Advanced Flag Analysis
The Advanced Flag Analysis tab contains settings to specify specific criteria (size,
concentration range, various logic criteria) to be met within the data, and
generate a table with results (Figure 36). These settings are described in detail in
“Global Configuration – Advanced Flag” on page 102.

Figure 36
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Advanced Flag tab in Set Individual Parameters dialog
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This chapter provides an overview of the Global Configuration dialog of the
ProSize software. It also provides information on setting individual configuration
parameters in opened data files.
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About Configuration
The Global Configuration dialog (or Set Individual Parameters dialog for opened
data files) is used to load, edit, or save the data analysis mode and settings for
processing the data file, such as size calibration, marker/sample peak
integration, quantification, smear analysis, and/or flag analysis criteria.
By using established method configurations for the different types of sample
analysis on the instrument, the user can streamline data analysis with the
ProSize software. This requires, that the first 10 characters of the ProSize
configuration file name matches the first 10 characters of the parallel capillary
electrophoresis system.

NOTE
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In most cases, predefined, optimized global configuration files are available to
load when processing data collected from different Agilent Reagent Kits. The
configuration files are labeled according to the particular kit number, e.g.,
DNF-910-33 – 35-1500bp.ini. These configuration files are available from Agilent
upon request if needed. The configuration files preloaded upon software
installation are located in the C:\ProSize data analysis software\Configurations
folder.
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Access Configuration Information in the ProSize
Software
There are two ways to access configuration information in the ProSize software:

Global Configuration Dialog
This option is used to define how an unprocessed data file is first opened in the
ProSize software. The user is automatically prompted with the Global
Configuration dialog when opening an unprocessed data file if the corresponding
separation method used does not match the naming configuration (Figure 37).
Alternatively, once a data file is opened, the user can modify at any time the
configuration by selecting Option, and clicking Edit Configurations
.

NOTE

In most cases, predefined, optimized global configuration files are available to
load when processing data collected from different Agilent Reagent Kits. The
configuration files are labeled according to the particular kit number, for example,
DNF-910-33 – 35-1500bp.ini. These configuration files are available from Agilent
upon request if needed. The configuration files preloaded upon software
installation are located in the C:\ProSize data analysis software\Configurations
folder.
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Figure 37

Global Configuration dialog

Set Individual Parameters Dialog
This dialog is used to modify or change configuration settings after a data file is
opened. The Set Individual Parameters dialog can be accessed in an open data
file by selecting
on the right side of the main menu (Figure 38). Note that
this icon toggles between the Set Individual Parameters and Show Results ( )
form, which displays the Peak Table and Smear Analysis or Flag Analysis tables.
For some modes (DNA, NGS), the Set Individual Parameters dialog also has a
DQN tab, which allows users to set a threshold for a DNA Quality Number. The
percent of DNA above the threshold, divided by 10, gives the DQN (which is an
indication of quality, based on a scale of 1 to 10).
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NOTE

Using Set Individual Parameters dialog, the currently selected tab is applied
independently from the other configuration tabs. In addition, if the user select
[Enter] after changing a setting, the change is only applied to the currently
selected sample; therefore this is a “local” setting. To apply the change made in
the tab to all samples, click Apply to All; to apply the change only to selected
samples, click Apply to Selected.
The settings within each tab of the Global Configuration and Set Individual
Parameters dialog perform the same functions. Each tab of the configuration is
discussed in further detail in the following sections of this chapter.

Figure 38

Set Individual Parameters icon for configuration settings after a data file is opened
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Overview Global Configuration Dialog
There are ten tabs in the Global Configuration dialog to define the appropriate
data analysis mode and settings for processing the data, as described in the
following sections.
At the bottom of the Global Configuration dialog, the user is able to Save, Load, or
Apply the configuration settings (see Table 23).
Table 23
Button

Global Configuration dialog buttons
Description
Saves the global configuration as a user defined file (*.ini format).
The settings from all tabs are saved, regardless of which tab is
open when saving the file.
Loads a predefined configuration file (*.ini format). Note than upon
installation, predefined configuration files are installed for most
Agilent Reagent Kits in the in the
C:\ProSize data analysis software\Configurations folder.
Applies the current global configuration settings to the data file. If
the data file is unprocessed, pressing the Apply button will open
the data file with the currently loaded settings. If the data file is
already open, the new settings will be applied to the data,
overwriting any previously defined individual configuration
settings.
Cancels all changes and closes the global Configuration window.
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Global Configuration - Advanced Settings
The settings of the Advanced Settings tab allow the user to assign the data
analysis mode for processing data (Figure 39). The settings are described in
detail in Table 24.

Figure 39

Advanced Settings tab in Global Configuration dialog

Table 24

Advanced Settings configuration tab

Settings

Description

Mode
DNA

For analyzing standard dsDNA fragment (for example, PCR product)
samples where discrete, Gaussian peaks are present. This mode displays
size in basepairs (bp) using a DNA Standard Ladder for calibration.
Quantification is achieved via comparison to either an upper or lower
marker, or to the DNA Standard Ladder present at a known concentration.
Note: The DNA Mode is not recommended for samples containing
non-Gaussian peaks, smears or uneven baselines.
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Advanced Settings configuration tab

Settings

Description

RNA (Eukaryotic)

For analyzing eukaryotic total RNA samples. Calculates size in nucleotides
(nt) using a RNA Standard Ladder for calibration. Quantification is achieved
via comparison of the lower marker to the RNA Ladder, present at a known
concentration. The ratio of the 18S and 28S ribosomal RNA peaks is
calculated, as well as the RNA Quality Number (RQN).

RNA (Prokaryotic)

For analyzing prokaryotic total RNA samples. Calculates size in nucleotides
(nt) using a RNA Standard Ladder for calibration. Quantification is achieved
via comparison of the lower marker to the RNA Ladder, present at a known
concentration. The ratio of the 16S and 23S ribosomal RNA peaks is
calculated, as well as the RNA Quality Number (RQN).

RNA (Plant)

For analyzing plant total RNA samples. Calculates size in nucleotides (nt)
using a RNA Standard Ladder for calibration. Quantification is achieved via
comparison of the lower marker to the RNA Ladder, present at a known
concentration. The ratio of the 18S and 25S ribosomal RNA peaks is
calculated, as well as the RNA Quality Number (RQN).

mRNA

For analyzing messenger RNA (mRNA) samples. Calculates size in
nucleotides (nt) using a RNA Standard Ladder for calibration. Quantification
is achieved via comparison of the lower marker to the RNA Ladder, present
at a known concentration.

Small RNA

For analyzing mico RNA (miRNA) samples. Calculates %microRNA, small
RNA (pg/µL), microRNA (pg/µL), and size in nucleotides (nt) using a RNA
Standard Ladder for calibration. Quantification is achieved via comparison
of the lower marker to the RNA Ladder, present at a known concentration.

NGS

For analyzing dsDNA samples containing peaks, smears, non-Gaussian
peaks and/or uneven baselines. This mode is commonly used for Next
Generation Sequencing (NGS) fragment library analysis.
This mode displays size in basepairs (bp) using a DNA Standard Ladder for
calibration. Quantification is achieved via comparison to either an upper or
lower marker, or to the DNA Standard Ladder present at a known
concentration.
The Peak Table in this mode displays additional fields for size range,
average size, and % CV.
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Table 24

Advanced Settings configuration tab

Settings

Description

Mutation Analysis

This mode is used in combination with TILLING experiments analyzed on
the Fragment Analyzer system. Displays size in basepairs (bp) using a
DNA Standard Ladder for calibration. Quantification is achieved via
comparison to either an upper or lower marker, or to the DNA Standard
Ladder present at a known concentration.
In this mode, an additional field for % Error is displayed in the Advanced
Settings tab. If the size of any two fragments in the sample adds up to the
size of the largest detected fragment (assumed to be the intact gene) within
the percentage entered in the % Error field, the peaks will be highlighted in
the Peak Table and Electropherogram Trace. The user can also select
peaks that meet a minimum peak height requirement with Min. RFU.

gDNA

For analyzing dsDNA samples containing peaks, smears, non-Gaussian
peaks and/or uneven baselines. his mode is commonly used for Genomic
DNA (gDNA) analysis.
This mode displays size in basepairs (bp) using a DNA Standard Ladder for
calibration. Quantification is achieved via comparison to a lower marker, or
to the DNA Standard Ladder present at a known concentration.
The Peak Table in this mode displays additional fields for size range,
average size, % CV, and GQN.

Restriction Digest

For analyzing standard dsDNA fragment (e.g., PCR product) samples where
discrete, Gaussian peaks are present. This mode displays size in basepairs
(bp) using a DNA Standard Ladder for calibration. Quantification is achieved
via comparison to either an upper or lower marker, or to the DNA Standard
Ladder present at a known concentration. The mode can be used for
analyzing samples cleaved with restriction enzymes.
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Table 24

Advanced Settings configuration tab

Settings

Description

Linear Interpolation

This mode uses two markers—one above and one below a target fragment.
In this case, ladder is not used. The size is based on linear interpolation
between the upper and lower marker.

High Sensitivity

Changes the display (export, .pdf, peak table) to pg/µL instead of ng/µL. For
NGS analysis only (and only for very low concentrations).

Min. RFU

Allows you to designate the minimum RFU required for integration.

Show Marker Information
on Peak Table

When enabled, the sample Peak Table will display size and concentration
information for the lower/upper marker peaks along with all currently
integrated sample peaks.

Global Configuration - Peak Analysis
The settings of the Peak Analysis tab allow the user to assign width and height
thresholds for selecting and integrating sample peaks; setting data filtering; and
selecting the time region to be analyzed (Figure 40). The settings are described
in detail in Table 25.
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Figure 40

Peak Analysis tab in Global Configuration dialog

Table 25

Peak Analysis configuration settings

Settings

Description

Peak Analysis
Peak Width (sec)

Defines the width threshold for peak detection in seconds. Higher
settings better define wide peak start/end points; smaller settings better
define sharp peak start/end points.
Typical values range from 3-5 for sharp peaks or 25-50 for smears. The
maximum value for this setting is 50.

Min. Peak Height (RFU)

Defines the minimum peak height threshold to select a peak for
integration in RFUs. Peaks below the set value will not be selected for
integration.
Typical values for this setting are 20-100 RFU, depending upon the
sample signal and application. Note the typical baseline peak-to-peak
noise is less than 5 RFU.
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Table 25

Peak Analysis configuration settings

Settings

Description

# Extra Valley Points

This setting influences the start/end point of baseline integration of
peaks and the baseline drawn between peaks. This setting most affects
the baseline between two peaks that are not baseline resolved. Higher
values draw a straighter baseline between the first peak start point and
second peak end point; lower values draw the baseline more to the
“valley” between the two unresolved peaks.
Note: The Valley to Valley Baseline? setting needs to be enabled for this
setting to be active.

Valley to Valley Baseline?

This setting influences the start/end point of baseline integration of
peaks and the baseline drawn between peaks. This setting most affects
the baseline between two peaks that are not baseline resolved. When
disabled, will draw a straighter baseline between the first peak start point
and second peak end point. When enabled, will draw the baseline more
to the “valley” between the two unresolved peaks.
In the example below, the Top trace shows the baseline drawn when
Valley to Valley Baseline is enabled; the Bottom trace shows the baseline
for the same sample when this setting is disabled.

Valley to Valley = Enabled

Valley to Valley = Disabled
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Table 25

Peak Analysis configuration settings

Settings

Description

Filter Selection
Filter

Defines the algorithm type to use when filtering the raw data. There are
five options for data filtering available to the user:
• None: No filtering is performed on the data.
• Moving Average: Averages points on either side of a point.
• Savitzky Golay: A polynomial regression filter where the coefficients
are calculated using Savitzky and Golay’s algorithm.
• Binomial:. A polynomial regression filter based on the binomial
coefficients for implementing Gaussian filtering.
• Wavelets De-noising: A discrete wavelet transform filter.
Note: The recommend filter for most applications is a 3 to 20 point
Binomial filter.

# of Points

Defines the number of points to use in the selected data filter.
Maximum points to use for each filter type:
• Moving Average: 9
• Savitsky Golay: 9
• Binomial: 20
• Wavelets De-Noising: 4

Analysis Region
Start (min)

Defines the start time in minutes for which to integrate and analyze the
electropherogram data. This includes both marker and sample peaks.
Note: If 0 is entered, will analyze data from start of the electropherogram
at 0 min.

End (min)

Defines the end time in minutes for which to integrate and analyze the
electropherogram data. This includes both marker and sample peaks.
Note: If 0 is entered, will automatically analyze data to the full end time
range of the electropherogram.

Manual Baseline Setpoints

Defines the baseline using time points. This function is particularly
useful for accurately measuring the total concentration of samples
containing smears or uneven baselines.
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Peak Analysis configuration settings

Settings

Description

Start (min)

Defines the start time in minutes for which to draw the start of the
baseline when manually setting the baseline. The Y axis position of the
baseline at the entered start point in minutes will be used to form the
new baseline start point.
Note: If 0 is entered for both the Start (min) and End (min), this function
is disabled. When entering values for this function, enter the ending time
value in the Start (min) field first. When next entering the start time the
end time value will automatically populate the End (min) field.

End (min)

Defines the end time in minutes for which to draw the end of the
baseline when manually setting the baseline. The Y-axis position of the
baseline at the entered end point in minutes will be used to form the new
baseline end point.
Note: If 0 is entered for both the Start (min) and End (min), this function
is disabled. When entering values for this function, enter the ending time
value in the Start (min) field first. When next entering the start time, the
end time value will automatically populate the End (min) field.
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Global Configuration - Marker Analysis
The settings of the Marker Analysis tab allow the user to select the criteria for
choosing the lower and/or upper peak, used to normalize each capillary by
migration time and concentration (Figure 41). The settings are described in detail
in Table 26.
In ProSize, the user can independently set different peak parameters for the
lower/upper markers from those set for the sample peak parameters in Peak
Analysis tab. This is useful if, for example, the sample contains broad smearing
peaks as compared to markers, which are typically sharp Gaussian peak profiles.
The user can select a lower/upper marker pair (Use Both Markers), or use only a
lower marker (Use Lower Marker Only) or upper marker (Use Upper Marker Only)
for data normalization by selecting the appropriate drop-down option.

Figure 41

Marker Analysis tab in Global Configuration dialog

The markers can be selected based on peak width and peak height thresholds,
and also by time range in the Marker Information section (Figure 42).
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Figure 42

Marker Analysis tab showing marker selection options

The lower marker can be selected as the First Peak, or second peak (F + 1), third
peak (F + 2), etc. up to the sixth peak above a threshold value in RFU units.
Similarly, the upper marker can be selected as the Last Peak, or L – 1, L – 2, etc.
Markers can also be selected based upon a time window, by selecting Between
from the drop-down and entering a time in X min +/- Y min. For example, the right
image of Figure 42 shows lower marker selection criteria of a peak > 200 RFUs
between 8 – 12 min (10 min +/- 2 min).

NOTE

The Min. Peak Height (RFU) setting under Marker Peak Analysis sets the primary
height threshold for the markers. The height threshold values for each individual
marker shown under Marker Information must therefore be equal to or greater
than the Min. Peak Height (RFU) value.
The settings of the Marker Analysis tab are described in Table 26.
Table 26

Marker Analysis configuration settings

Settings

Description

Marker Peak Analysis
Peak Width (sec)
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Defines the width threshold for peak detection and peak start/end
point in seconds. Higher values better define wide peak start/end
points; smaller settings better define sharp peak start/end points.
Typical values are 3-5 for marker peaks.
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Table 26

Marker Analysis configuration settings

Settings

Description

Min. Peak Height (RFU)

Defines the minimum peak height threshold to select a marker peak in
RFUs. Peaks below the set value will not be selected as markers.

# Extra Valley Points

This setting influences the start/end point of baseline integration of the
marker peaks and the baseline. This setting most affects the baseline
between two peaks that are not baseline resolved. Higher values draw
a straighter baseline between the first peak start point and second
peak end point; lower values draw the baseline more to the “valley”
between the two unresolved peaks.
Note: The Valley to Valley Baseline? setting needs to be enabled for
this setting to be active.

Valley to Valley Baseline?

This setting influences the start/end point of baseline integration of the
marker peaks and the baseline. This setting most affects the baseline
between two peaks that are not baseline resolved. When disabled, will
draw a straighter baseline between the first peak start point and
second peak end point. When enabled, will draw the baseline more to
the “valley” between the two unresolved peaks.

Use Both Markers

Normalizes and aligns the CE data to both a selected lower and upper
size marker.

Use Lower Marker Only

Normalizes and aligns the CE data to only the selected lower marker.

Use Upper Marker Only

Normalizes and aligns the CE data to only the selected upper marker.

Marker Information
Lower Marker

This setting determines how the lower marker is selected from the CE
data, using the threshold value in RFU as the minimum peak height for
selection. The lower marker is selectable from the drop-down control
as:
• First Peak (F)
• F + 1, F + 2, F +3, F + 4, or F +5
• Between: Enter a specific time in X minutes +/- Y min

Upper Marker

This setting determines how the upper marker is selected from the CE
data, using the threshold value in RFU as the minimum peak height for
selection. The upper marker is selectable from the drop-down control
as:
• Last Peak (L)
• L - 1, L - 2, L - 3, L - 4, or L - 5
• Between: Enter a specific time in X minutes +/- Y min
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Global Configuration - Peak Analysis for Reference Cap
The settings of the Peak Analysis for Reference Cap tab allow the user to assign
width and height thresholds for selecting and integrating peaks in the “Reference“
capillary, which is the assigned well containing the DNA or RNA Ladder used to
calibrate size (Figure 43). The settings are described in detail in Table 27.
This feature enables the user to define a higher threshold for the ladder peaks as
compared to the sample peaks.

Figure 43

Peak Analysis for Reference Cap tab in Global Configuration dialog

Table 27

Peak Analysis for Reference Cap configuration settings

Settings

Description

Peak Analysis
Peak Width (sec)
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Defines the width threshold for peak detection in seconds. Higher settings
better define wide peak start/end points; smaller settings better define
sharp peak start/end points.
Typical values range from 3-5 for sharp peaks.
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Table 27

Peak Analysis for Reference Cap configuration settings

Settings

Description

Min. Peak Height (RFU)

Defines the minimum peak height threshold to select a peak for integration
in RFUs. Peaks below the set value will not be selected for integration.
Typical values for this setting when working with a DNA or RNA Ladder
100-200 RFU, depending upon the ladder concentration and application.

# Extra Valley Points

This setting influences the start/end point of baseline integration of peaks
and the baseline drawn between peaks. This setting most affects the
baseline between two peaks that are not baseline resolved. Higher values
draw a straighter baseline between the first peak start point and second
peak end point; lower values draw the baseline more to the “valley”
between the two unresolved peaks.
Note: The Valley to Valley Baseline? setting needs to be enabled for this
setting to be active.

Valley to Valley Baseline?

This setting influences the start/end point of baseline integration of peaks
and the baseline drawn between peaks. This setting most affects the
baseline between two peaks that are not baseline resolved. When disabled,
will draw a straighter baseline between the first peak start point and
second peak end point. When enabled, will draw the baseline more to the
“valley” between the two unresolved peaks.

Global Configuration - Size Calibration
The settings of the Size Calibration tab allow the user to select the proper
“Reference” well containing a DNA or RNA Ladder for calibration of sample size;
to enter in the proper size and number of fragments (including lower/upper
markers) in the calibration ladder; and to apply a fit algorithm for plotting the size
vs. migration time data from the ladder (Figure 44). The settings are described in
detail in Table 28.
In ProSize, the user can calibrate the size of sample fragments either by running
a standard DNA or RNA ladder in a well of the sample plate (recommended), or
by importing a previously calculated and exported size calibration file (*.scal
extension).

NOTE

If an imported size calibration is used in ProSize, the same Separation Gel,
capillary array dimensions, injection/run voltage, and lower/upper markers
should be used for both the analyzed data and the imported calibration to ensure
maximum sizing accuracy.
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To properly calibrate the size, the size ladder must be bracketed by the same
lower/upper markers used with the samples. In some cases, the lower or upper
marker may co-migrate with a ladder peak; this is acceptable for sizing
calibration. In some application kits (for example, RNA and Genomic DNA kits),
only a lower marker is used; the data is hence normalized using the lower marker
only compared to the respective DNA or RNA Size Ladder.

Figure 44

Size Calibration tab in Global Configuration dialog

It is important to ensure the sample containing the size calibration ladder
(“Reference” well) has all ladder fragments integrated correctly with no additional
peaks integrated prior to analyzing the remaining samples.
The size of each fragment to be included in the DNA/RNA Ladder (including
lower/upper markers) is entered directly or imported into the Calibration Ladder
field. To directly enter a value, click in the field and enter the size value.
A context menu is available when selecting the Calibration Ladder table. It offers
options such as inserting or deleting fragments in the table; clearing all entries;
and importing or exporting ladder information files (*.txt extension).
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NOTE

In most cases, predefined ladder information files optimized for different Agilent
reagent kits are available and are loaded as part of the Global Configuration. The
ladder files are labeled according to the particular kit number, for example,
DNF-910 - 35-1500 100 bp ladder.txt. These ladder files are available from Agilent
upon request if needed. The preloaded ladder files are located in the Ladders
folder under C:\ProSize data analysis software.
Table 28

Size Calibration configuration settings

Settings

Description

Calibration Ladder

Lists size of DNA/RNA fragments contained in
calibration ladder in tabular format. The size of each
fragment (include lower/upper markers) is entered
directly into the table or imported by using the
context menu (right-click in the Calibration Ladder
table).

Calibration Ladder > Insert Before

Inserts a blank cell above the currently selected cell
in the calibration ladder table.
Note: Click in the respective table cell before using
this option.

Calibration Ladder > Delete Current Selection

Deletes the currently selected cell in the calibration
ladder table.
Note: Click in the respective table cell before using
this option.

Calibration Ladder > Clear All

Deletes all cells in the calibration ladder table.

Calibration Ladder > Import

Imports a previously exported and saved sizing
ladder information file. When selected, a file
browser menu will open to navigate and select the
desired file (*.txt extension). Standard ladder
information files are located in the
C:\ProSize data analysis software\Ladders folder.

Calibration Ladder > Export

Exports the current sizing ladder table information
(*.txt extension). When selected, a file browser
menu will open to navigate and save the desired
filename and location. When exporting ladder
information files, it is highly recommended to save
the created files to a common directory, located in
the C:\ProSize data analysis software\Ladders
folder.

Default Ladder Well

Defines the well of the sample plate, which contains
the size calibration ladder. From the drop-down list,
select the proper row (A-H) and column (1-12)
location containing the size calibration ladder.

ProSize Data Analysis Software User Manual

95

4

ProSize Configuration
Global Configuration - Quantification

Table 28

Size Calibration configuration settings

Settings

Description

Curve Fitting

• Point to Point
Fits the size calibration plot of Size (bp or nt) vs.
Time (sec) with a Point to Point fit (recommended),
drawing a straight line between each point of the
curve.
• Polynomial
Fits the size calibration plot of Size (bp or nt) vs.
Time (sec) with a polynomial fit. Enter the order
value (from 3 to 5) in the Order field.

Use Imported Ladder Profile

Imports a previously exported size calibration file
(*.scal extension) to use for size calibration.

Ladder Profile

Displays file path for the imported size calibration
file. To load an imported file, click
. A file
browser menu will open to navigate and select the
desired file (*.scal extension).
Note: When importing a size calibration file, the
same conditions (separation gel, capillary array
length, lower/upper markers, CE separation
voltage) should be used. Differences between the
analyzed and imported conditions will adversely
affect the sizing accuracy.

Further information on the Size Calibration function is described in chapter
Chapter 5, “ProSize Size Calibration Screen”.

Global Configuration - Quantification
The settings of the Quantification tab allow the user to assign how the sample is
quantified in the ProSize software (by markers or ladder); to define the working
concentration of the marker or ladder reference; and to apply a dilution factor for
calculating the final sample concentration (Figure 45). The settings are
described in detail in Table 29.
There are two different methods by which the sample concentration may be
quantified in the ProSize software:
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•

Use Lower/Upper Marker: This method compares the sample peak or sample
smear area to either the lower or upper marker peak area. The peak areas are
taken as corrected peak area (area/migration time), with each data point
collected being divided by its migration time. This method relies on a marker
of known concentration, typically mixed directly with the sample.

•

Use Ladder: This method compares the sample peak or sample smear area to
that of a RNA or DNA ladder of known total concentration. The ratio of the
RNA/DNA ladder to the lower marker is calculated; then the ratio of the lower
marker to the sample is calculated to determine the final sample
concentration. This method relies on a RNA/DNA ladder of known
concentration, typically mixed directly with the sample.
An advantage of the Use Ladder quantification method is that it can correct for
any systematic errors in sample preparation. As long as the sample and
ladder are prepared using the same diluent marker solution, any bias from
pipetting or preparation is accounted for as long as the RNA/DNA Ladder is
pipetted and mixed the same as the sample.

Use Ladder is the default Quantification method for all quantification analysis
kits. For the various modes, the user may select from either the Use Lower/Upper
Marker or the Use Ladder method. Refer to the corresponding User Manual for
each specific Agilent reagent kit for suggested settings.

NOTE

The most accurate means of quantification involves diluting the sample in a
diluent containing marker of known concentration (internal standard).
Approximate concentration or relative concentration differences between
samples can also be obtained by diluting a sample in a diluent matrix (e.g., 1X TE
buffer) that matches that of markers prepared in a separate marker plate, and
injected under identical conditions (voltage/time).
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Figure 45

Quantification tab in Global Configuration dialog (Left: Use Ladder selected; Right: Use Upper
Marker selected)

Table 29

Quantification configuration settings

Settings

Description

Use Lower Marker

Uses the ratio of the sample corrected peak area to the lower marker corrected
peak area for calculation of sample peak/smear quantification.

Use Upper Marker

Uses the ratio of the sample corrected peak area to the upper marker corrected
peak area for calculation of sample peak/smear quantification.

Use Ladder

Compares the total corrected peak area of the ladder to the lower marker. The
result will be ratioed to the corrected peak area of sample compared to its
respective lower marker peak.
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Table 29

Quantification configuration settings

Settings

Description

Final Conc. (ng/µL)

The value of final working concentration in ng/mL of the marker or ladder to be
used for quantification.
Example: In the RNA Kit (DNF-471), the RNA Ladder is diluted 12X (2 µL Ladder +
22 µL diluent) and has a starting concentration of 96 ng/mL. Therefore, the Final
Conc. (ng/µL) value is set to 8 ng/µL and the Dilution Factor is set to 12.

Dilution Factor

The multiplication factor to be applied to the sample or ladder to account for any
pre-dilution steps prior to analysis.
Note: This value may differ between samples depending upon whether a sample
has been pre-diluted prior to analysis.
For example, in the HS NGS Fragment Kit, 2 L of sample is diluted into 22 L of
diluent/marker solution; a dilution factor of 12 should therefore be used when
using the Use Ladder quantification method for the ProSize software to
accurately output the starting sample concentration.
Note: A Dilution Factor of 1 indicates no dilution of the sample.

Global Configuration - Smear Analysis
The settings of the Smear Analysis tab allow the user to specify a size range(s)
for which to integrate and calculate the total concentration in ng/mL. This is
useful for example for DNA smears, where knowledge of the concentration of a
specific size range within a smear is more important than that of the total smear
size range (Figure 46). The settings are described in detail in Table 30.
Several different size ranges can be applied at once to a sample; the calculated
total concentration within the specified range is presented in a tabular format
that can be exported in a .csv format or printed as a hard copy PDF report.
If one or more selections are entered in the Smear Analysis tab, upon opening the
data a Smear Analysis tab will displayed next to the Peak Analysis tab, with each
individual result populating a separate line, showing the calculated
concentrations for each range.
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Figure 46

Table 30

Smear Analysis tab in Global Configuration dialog

Smear Analysis configuration settings

Settings

Description

Start Size (bp)

Defines the lower size threshold (in bp) to include in the calculation of total concentration.
Note: If the entered size is in the middle of a peak/smear, the concentration is calculated from that
size and higher and will not include the portion of the peak/smear below the size threshold.

End Size (bp)

Defines the upper size threshold (in bp) to include in the calculation of total concentration.
Note: If the entered size is in the middle of a peak/smear, the concentration is calculated from that
size and below and will not include the portion of the peak/smear above the size threshold.

Insert Before

Context menu option of the Smear Analysis table. Inserts a blank cell row above the currently
selected cell in the table.
Note: Click in the respective table cell before using this option.

Delete Current Selection

Context menu option of the Smear Analysis table. Deletes the currently selected cell row in the
table. Note: Click in the respective table cell before using this option.

Clear All

Context menu option of the Smear Analysis table. Deletes all cells in the table.
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Global Configuration - Flag
The settings of the Flag tab allow the user to specify specific criteria (size or
concentration range) to be met within the data, and generate a binary output
(0 = false, 1 = true) of the results. This is useful for applications (for example,
genotyping) where the presence/absence of bands is to be scored (Figure 47).
The settings are described in detail in Table 31.
Flag criteria can be set based on size, concentration, peak height and/or
corrected peak area. Boolean logic is applied to the criteria for establishing
various condition.
If one or more selections are entered in the Flag tab, upon opening the data an
additional Flag Analysis tab will be displayed with the Peak Table for each
individual results, displaying the flag results in a binary 1/0 format.

Figure 47

Flag tab in Global Configuration dialog

Table 31

Flag configuration settings

Settings

Description

Tag

Allows naming of the flag condition being used.

Value

Defines the numerical value of the unit for the flag condition.
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Table 31

Flag configuration settings

Settings

Description

Unit

Drop-down list which defines the units of the condition to flagged. The first Unit
is always size (bp or nt) based; for the second Unit criteria there are four
secondary flagging options:
• bp (size)
• ng/mL (concentration)
• nmole/L (concentration)
• RFU (Relative Fluorescence Units)

Range

Defines the numerical range to use for applying the flag condition. The
drop-down to the left of this field determines the operation to apply:
• ± (will flag the value entered with a plus and minus range)
• > (will flag when greater than the range)
• < (will flag when less than the range)
• = (will flag when equal to the range)

Boolean Operation

Drop-down list which defines the Boolean operation to apply to the flag
condition. There are five options to apply:
• ---: No second flag condition is applied.
• AND: Both the first and second flag condition must apply to be true
• OR: First or second flag condition must apply to be true
• AND NOT: The first flag condition must apply and the second must not
apply to be true
• NOR: Both the first and second flag condition must not apply to be true

Flag Analysis Clear All

Clears all existing flag conditions from the table.

Checkbox

Clears the corresponding row flag condition entry.

Global Configuration – Advanced Flag
The Advanced Flag tab allows the user to define more complex flag conditions.
However, only a single set of advanced flag conditions can be applied to all 96
capillaries.
In contrast, Set Individual Parameters dialog allows unique flag conditions for
each individual well. A plate map of individual flag conditions can be defined,
saved, and re-applied to new plates. An entire plate map of advanced flag
conditions may be applied to all 96 capillaries, where each advanced flag
condition is different for each capillary.
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Add a Flag Criteria
You can define complex flag criteria with an unlimited number of conditions. A
criteria can be set based on size, concentration, peak height, RFU and/or
corrected peak area. Boolean logic is applied to the criteria for establishing
various conditions. This is useful for applications (for example, genotyping)
where a complex flag pattern analysis is required.
1 In the Advanced Flag tab, double-click Add.

The Criteria Input window opens. The settings are described in Table 33.

ProSize Data Analysis Software User Manual

103

4

ProSize Configuration
Global Configuration – Advanced Flag

2 Enter the flag criteria (size, concentration range, RFU range, mixed fragment
criteria, etc.) to be met within the data. This will be used for the result output
table.
If one or more selections are entered in the Advanced Flag tab, upon opening the
data an additional Advanced Flag Analysis tab will be displayed with the Peak
Table.

Saving Formats for Flag Conditions
•

If you want an individual flag condition to be applied as one of several flag
conditions within a well, save the flag as .template.

•

If you want a set of flag conditions to be applied to an individual well (which
may contain one or more individual conditions), save the flag as .SCtmpt
(where SC is abbreviated for single capillary).

•

If you want a set of flag conditions to be applied to an entire plate, where each
well may have different flag conditions (which can be applied only in the “Set
Individual Parameters” discussed later in this chapter), save the flag as
.ACtmpt (where “AC” stands for “all capillaries”).

Table 32 describes the settings of the Advanced Flag tab.
Table 32

Advanced Flag configuration settings

Settings
Add…..

Double-click opens the Criteria Input window. Allows to enter a set of flag
conditions.

Context menu
Load From Template

Opens and applies a pre-defined set of flag condition (previously created
and saved by user) for an individual well (.SCtmpt). The same set of
conditions defined by the .SCtmpt file are applied to all 96 capillaries.

Save to Template

Saves the flag template as .SCtmpt for the single well—applied to all 96
capillaries (i.e., the same flag condition is applied to all 96 capillaries).

Clear Selected

Clears a selected flag condition (which are applied to all 96 capillaries).

Clear All

Clears all flag conditions (for all 96 capillaries).

Table 33
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Criteria Input settings to define a flag condition

Settings

Description

Title

To name the set of conditions being used (which may include several tags).

Tag

To name an individual flag condition being used.
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Table 33

Criteria Input settings to define a flag condition

Settings

Description

Value

Defines the numerical value of the unit for the flag condition.

Unit

Drop-down list which defines the units of the condition to flagged. The first
Unit is always size (bp or nt) based; for the second Unit criteria there are
four secondary flagging options:
• bp (size)
• ng/µL (concentration)
• nmole/L (concentration)
• RFU (Relative Fluorescence Units)

Range

Defines the numerical range to use for applying the flag condition. The
drop-down to the left of this field determines the operation to apply:
• ± (will flag the value entered with a plus and minus range)
• > (will flag when greater than the range)
• < (will flag when less than the range)
• = (will flag when equal to the range)

Boolean Operation

Drop-down list which defines the Boolean operation to apply to the flag
condition. There are five options to apply:
• ---: No second flag condition is applied.
• AND: Both the first and second flag condition must apply to be true
• OR: First or second flag condition must apply to be true
• AND NOT: The first flag condition must apply and the second must not
apply to be true
• NOR: Both the first and second flag condition must not apply to be true

Accept

To accept the flag conditions defined for the individual well

Load

To load an individual set of flag conditions (*.template). Note that multiple
individual flag conditions can be applied to the same well.
For example: 200 bp only; 300 bp AND 500 bp; 600 bp only.

Save

Saves an individual flag condition (*.template). Note that multiple individual
flag conditions can be applied to the same well.
For example: 200 bp only; 300 bp AND 500 bp; 600 bp only.

Cancel

Cancels any information entered and closes screen.
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Global Configuration – Inclusion Region
The settings of the Inclusion Region tab allow the user to define up to four size
inclusion ranges. Only peaks (excluding markers) that fall into the defined
range(s) will be displayed. This will affect the screen display, PDF reports and
exported data. The Inclusion Region tab is shown in with functions described in
Table 34.
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Figure 48

Inclusion Region tab in Global Configuration dialog

Table 34

Inclusion Region configuration settings

Settings

Description

Start Size (bp)

Defines the lower size boundary (in bp) of the Inclusion Region. Peaks
(with the exception of the Lower Marker) smaller than the lower
boundary will not be displayed.

End Size (bp)

Defines the upper size boundary (in bp) of the Inclusion Region. Peaks
(with the exception of the Upper Marker) larger than the upper boundary
will not be displayed.
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Table 34

Inclusion Region configuration settings

Settings

Description

Insert Before

Context menu option of the Inclusion Region table. Inserts a blank cell
row above the currently selected cell in the table.
Click in the respective table cell to use this option.

Delete Current Selection

Context menu option of the Inclusion Region table. Deletes the
currently selected cell row in the table. Click in the respective table cell
to use this option.

Clear All

Context menu option of the Inclusion Region table. Deletes all cells in
the table.
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Set Individual Parameters
After a data file is opened in the ProSize program, the configuration settings can
be adjusted for individual samples by the Set Individual Parameters option.
The Set Individual Parameters dialog consist of main tabs that can be adjusted
similar to those tabs in the Global Configuration dialog. RNA and Genomic
modes also present an extra tab specific to those analyses in the Set Individual
Parameters.
Some tabs can be applied to individual samples, while others can only be applied
to all samples:
•

Advanced Settings
When a file is open and the analysis mode is changed, all samples are
changed to the newly selected mode.

•

Peak Analysis
When a file is open, configuration settings of individual samples can be edited,
or all samples may be changed at once.

•

Marker Analysis
When a file is open, configuration settings of individual samples can be edited,
or all samples may be changed at once.

•

Quantification
When a file is open, configuration settings of individual samples can be edited,
or all samples may be changed at once.

•

Smear Analysis
When a file is open, configuration settings of individual samples can be edited,
or all samples may be changed at once.

•

Flag
When a file is open, all samples are changed to the current Flag settings and
cannot be individually adjusted.

•

DNA Quality Number
When a file is open, configuration settings of individual samples can be edited,
or all samples may be changed at once.
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•

Advanced Flag
When a file is open, configuration settings of individual samples can be edited,
or all samples may be changed at once.

•

Inclusion Region
When a file is open, configuration settings of individual samples can be edited,
or all samples may be changed at once.

•

Total RNA Exclusion Region
When a file is open, configuration settings of individual samples can be edited,
or all samples may be changed at once.

•

Small RNA Region
When a file is open, configuration settings of individual samples can be edited,
or all samples may be changed at once.

•

Genomic Quality Number
When a file is open, all samples are changed to the current GQN settings and
cannot be individually adjusted.

NOTE

When changing configuration settings in the Set Individual Parameters dialog, the
reference ladder well is treated separately from the sample wells. Therefore, if
Apply to All is performed on a sample well, the current reference ladder well will
not be updated.
If the user chooses Apply to All from the reference ladder well, all sample wells
including the ladder well will be updated.
At the bottom of the Set Individual Parameters dialog are two functions for setting
and loading the configuration, as shown in Figure 49 and summarized in
Table 35.
Table 35

Set Individual Parameters buttons

Button

Description

Set as Default Configuration

Sets the default configuration for all files that are subsequently
opened (i.e., the Global Configuration). This is useful if you
consistently open files of a similar type (i.e., all files are based on
the use of a ladder in well “A12” for example.

Load

Opens a file browser menu for loading a previously created
configuration file (*.ini extension). Navigate to the desired
directory location containing the configuration file, and click OK
to load.
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The settings of the tabs in the Set Individual Parameters dialog differ from those
in the Global Configuration dialog. The tabs are summarized in the following
sections.

Set Individual Parameters - Advanced Settings
The settings of the Advanced Settings tab allow the user to assign the data
analysis mode for processing data (Figure 49). The Minimum RFU for Signal
Processing is used to set a minimum RFU value for integration.

NOTE

When any change is made to the Mode, all samples are changed, including the
reference ladder well.

Figure 49

Advanced Settings tab in Set Individual Parameters dialog

Set Individual Parameters - Peak Analysis
Table 36 describes additional settings of the Peak Analysis tab not available in
the Global Configuration dialog. If the user changes a field and/or presses
[Enter], the new setting will be applied to the current selected sample well only.
The Peak Analysis tab is shown in Figure 50.
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Figure 50

Peak Analysis tab in Set Individual Parameters dialog

Table 36

Additional settings in the Peak Analysis tab

Settings

Description

Apply to All

All current settings of just the Peak Analysis tab will be applied to all samples of
the loaded data file. If this is applied in the reference ladder well, all samples and
the reference ladder will be updated; if this is applied in a sample well, all sample
wells but not the reference ladder will be updated.

Note: You should only select this option if you wish to apply all settings of the
Peak Analysis tab to all samples. Any previous changes made for the samples
of the data file will be overwritten.
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Table 36

Additional settings in the Peak Analysis tab

Settings

Description

Apply to Selected
Samples

Applies all current settings of just the Peak Analysis tab only to any user
specified wells of the sample plate. The Selected Samples plate map menu will
be displayed to select the wells of the sample plate to apply the settings to.
Select desired wells, rows, or columns, and click OK to apply; click Cancel to
abort the operation.
If this is applied in the reference ladder well, all samples and the reference ladder
will be updated; if this is applied in a sample well, all sample wells but not the
reference ladder will be updated.
Note: You should only select this option if you wish to apply all settings of the
Peak Analysis tab to the selected set of samples. Any previous changes to the
selected samples of the data file will be overwritten.

Set Individual Parameters – Marker Analysis
Table 37 describes additional settings of the Marker Analysis tab not available in
the Global Configuration. If the user changes a field and/or presses [Enter], the
new setting will be applied to the current selected sample well only. The Marker
Analysis tab is shown in Figure 51.

Figure 51
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Marker Analysis tab in Set Individual Parameters dialog
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Table 37

Additional settings of the Marker Analysis tab

Settings

Description

Apply to All

All current settings of just the Marker Analysis tab will be applied to all
samples of the loaded data file. If this is applied in the reference ladder
well, all samples and the reference ladder will be updated; if this is
applied in a sample well, all sample wells but not the reference ladder
will be updated.

Note: You should only select this option if you wish to apply all settings
of the Marker Analysis tab to all samples. Any previous changes made
for the samples of the data file will be overwritten.
Apply to Selected Samples

Applies all current settings of just the Marker Analysis tab only to any
user specified wells of the sample plate. The Selected Samples plate
map menu will be displayed to select the wells of the sample plate to
apply the settings to. Select desired wells, rows, or columns, and click
OK to apply; click Cancel to abort the operation.
If this is applied in the reference ladder well, all samples and the
reference ladder will be updated; if this is applied in a sample well, all
sample wells but not the reference ladder will be updated.
Note: You should only select this option if you wish to apply all settings
of the Marker Analysis tab to the selected set of samples. Any
previous changes to the selected samples of the data file will be
overwritten.

Set Individual Parameters – Quantification
Table 38 describes additional settings of the Quantification tab not available in
the Global Configuration. If the user changes a field and/or presses [Enter], the
new setting will be applied to the current selected sample well only. The
Quantification tab is shown in Figure 52.
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Figure 52

uantification tab in Set Individual Parameters dialog

Table 38

Additional settings in the Quantification tab

Settings

Description

Apply to All

All current settings of just the Quantification tab will be applied to all samples of
the loaded data file. If this is applied in the reference ladder well, all samples and
the reference ladder will be updated; if this is applied in a sample well, all sample
wells but not the reference ladder will be updated.

Note: You should only select this option if you wish to apply all settings of the
Quantification tab to all samples. Any previous changes made for the samples
of the data file will be overwritten.
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Table 38

Additional settings in the Quantification tab

Settings

Description

Apply to Selected
Samples

Applies all current settings of just the Quantification tab only to any user
specified wells of the sample plate. The Selected Samples plate map menu will
be displayed to select the wells of the sample plate to apply the settings to.
Select desired wells, rows, or columns, and click OK to apply; click Cancel to
abort the operation.
If this is applied in the reference ladder well, all samples and the reference ladder
will be updated; if this is applied in a sample well, all sample wells but not the
reference ladder will be updated.
Note: You should only select this option if you wish to apply all settings of the
Quantification tab to the selected set of samples. Any previous changes to the
selected samples of the data file will be overwritten.

Set Individual Parameters – Smear Analysis
Table 39 describes additional settings of the Smear Analysis tab not available in
the Global Configuration. If the user changes a field and/or presses [Enter], the
new setting will be applied to the current selected sample well only. The Smear
Analysis tab is shown in Figure 53.

Figure 53

Smear Analysis tab in Set Individual Parameters dialog
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Table 39

Additional settings in the Quantification tab

Settings

Description

Apply to All

All current settings of just the Smear Analysis tab will be applied to all
samples of the loaded data file. If this is applied in the reference ladder
well, all samples and the reference ladder will be updated; if this is
applied in a sample well, all sample wells but not the reference ladder
will be updated.

Note: You should only select this option if you wish to apply all settings
of the Smear Analysis tab to all samples. Any previous changes made
for the samples of the data file will be overwritten.
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Apply to Selected Samples

Applies all current settings of just the Smear Analysis tab only to any
user specified wells of the sample plate. The Selected Samples plate
map menu will be displayed to select the wells of the sample plate to
apply the settings to. Select desired wells, rows, or columns, and click
OK to apply; click Cancel to abort the operation.
If this is applied in the reference ladder well, all samples and the
reference ladder will be updated; if this is applied in a sample well, all
sample wells but not the reference ladder will be updated.
Note: You should only select this option if you wish to apply all settings
of the Smear Analysis tab to the selected set of samples. Any previous
changes to the selected samples of the data file will be overwritten.

Display Smear Range

When enabled, two vertical cursors are displayed in the
Electropherogram Trace screen. These cursors define the entered
values for the Start Size (bp) and the End Size (bp) for the currently
selected smear range.
The start and end points of the smear range can be adjusted by clicking
on a cursor peak, and dragging the respective cursor left or right; the
smear analysis region will be automatically updated to the new cursor
location.
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Set Individual Parameters – Flag Analysis
Table 40 describes additional settings of the Flag Analysis tab not available in the
Global Configuration. If the user changes a field and/or presses [Enter], the new
flag setting will be applied to all samples of the sample plate. The Flag Analysis
tab is shown in Figure 54.

Figure 54

Flag tab in Set Individual Parameters dialog

c

Additional Flag Analysis settings

Table 40
Setting

Description

Save Flag Parameters

When selected, the current Flag Analysis settings will be saved as a file
(*.Flag extension) that can be loaded into different data files. A file
browser menu will open to navigate and save the desired filename and
location; click OK to save the file, or Cancel to discard your changes.

Load Flag Parameters

When selected, the previously saved Flag Analysis settings will be loaded
from a file (*.Flag extension). A file browser menu will open to navigate
and load the desired filename and location; click OK to load the file, or
Cancel to discard your changes.

Remove All Flag Parameters

When selected, all settings will be cleared from the tab.
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Set Individual Parameters – DNA Quality Number
The settings of the DNA Quality Number tab allows the user to select the Size
Threshold (bp) required for the calculation of the DNA Quality Number
(Figure 55). Designed as a dynamic, user-defined quality metric for use with the
DNA and NGS modes under the Advanced Settings tab. The settings of the DNA
Quality Number tab are described in Table 41.

Figure 55

DNA Quality Number tab in Set Individual Parameters dialog

Table 41

Settings in the DNA Quality Number tab

Settings

Description

Size Threshold (bp)

Custom defined size threshold that the DNA Quality Number calculation is
based upon.
The DNA Quality Number (DQN) is calculated based on how much of the
sample exceeds the threshold. The DQN is composed of the percentage of
DNA above the threshold value divided by 10.

Apply to All

All current settings of just the DNA Quality Number tab will be applied to all
samples of the loaded data file. If this is applied in the reference ladder well,
all samples and the reference ladder will be updated; if this is applied in a
sample well, all sample wells but not the reference ladder will be updated.

Note: You should only select this option if you wish to apply all settings of the
DNA Quality Number tab to all samples. Any previous changes made for the
samples of the data file will be overwritten.
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Table 41

Settings in the DNA Quality Number tab

Settings

Description

Apply to Selected Samples Applies all current settings of just the DNA Quality Number tab only to any
user specified wells of the sample plate. The Selected Samples plate map
menu will be displayed to select the wells of the sample plate to apply the
settings to. Select desired wells, rows, or columns, and click OK to apply; click
Cancel to abort the operation.
If this is applied in the reference ladder well, all samples and the reference
ladder will be updated; if this is applied in a sample well, all sample wells but
not the reference ladder will be updated.
Note: You should only select this option if you wish to apply all settings of the
DNA Quality Number tab to the selected set of samples. Any previous
changes to the selected samples of the data file will be overwritten.

The DNA Quality Number tab can be activated or deactivated in the Option dialog.
From the menu, select Option, and enable DNA Quality Number (DQN). The dialog
and settings of the Options menu are described in Chapter 3, “ProSize Main
Screen”.

Set Individual Parameters – Advanced Flag Analysis
Advanced Flag allows the user to define more complex flag conditions.
The Advanced Flag tab in the Global Configuration dialog allows to apply only a
single set of flag conditions to all 96 capillaries. However, here in the Set
Individual Parameters dialog, unique flag conditions can be set up for each
individual well, and a plate map of individual flag conditions can be defined,
saved, and re-applied to new plates.

Add a Flag Criteria
Define complex flag criteria with an unlimited number of conditions. A criteria can
be set based on size, concentration, peak height, RFU and/or corrected peak
area. Boolean logic is applied to the criteria for establishing various conditions.
This is useful for applications (for example, genotyping) where a complex flag
pattern analysis is required.
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1 In the Advanced Flag tab, double-click Add (the settings are described in
Table 42).
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The Criteria Input window opens.

2 Enter the flag criteria (size, concentration range, RFU range, mixed fragment
criteria, etc.) to be met within the data. This will be used for the result output
table. The settings are described in Table 43.
If one or more selections are entered in the Advanced Flag tab, upon opening the
data an additional Advanced Flag Analysis tab will be displayed with the Peak
Table.
If you changes a field and/or click [Enter], the new flag setting will be applied to
only that well of the sample plate. To apply the conditions to all wells, select
Apply to all in the tab.

Saving Formats for Flag Conditions
•

If you want an individual flag condition to be applied as one of several flag
conditions within a well, save the flag as .template.

•

If you want a set of flag conditions to be applied to an individual well (which
may contain one or more individual conditions), save the flag as .SCtmpt
(where SC is abbreviated for single capillary).

•

If you want a set of flag conditions to be applied to an entire plate, where each
well may have different flag conditions (which can be applied only in the “Set
Individual Parameters”tab), save the flag as .ACtmpt (where “AC” stands for
“all capillaries”).
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Table 42

Advanced Flag configuration settings

Settings

Description

Add…..

Double-click opens the Criteria Input window. Allows to enter a set of flag
conditions.

Context menu
Load From Template

Opens and applies a pre-defined set of flag condition (previously created
and saved by user) for an individual well (.SCtmpt). The same set of
conditions defined by the .SCtmpt file are applied to all 96 capillaries.

Save to Template

Saves the flag template as .SCtmpt for the single well—applied to all 96
capillaries (i.e., the same flag condition is applied to all 96 capillaries).

Clear Selected

Clears a selected flag condition (which are applied to all 96 capillaries).

Clear All

Clears all flag conditions (for all 96 capillaries).

Apply to All

All current settings of just the Advanced Flag tab will be applied to all
samples of the loaded data file. If this is applied in the reference ladder well,
all samples and the reference ladder will be updated; if this is applied in a
sample well, all sample wells but not the reference ladder will be updated.

Note: You should only select this option if you wish to apply all settings of
the Advanced Flag tab to all samples. Any previous changes made for the
samples of the data file will be overwritten.
Apply to Selected Samples
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Applies all current settings of just the Advanced Flag tab only to any user
specified wells of the sample plate. The Selected Samples plate map
menu will be displayed to select the wells of the sample plate to apply the
settings to. Select desired wells, rows, or columns, and click OK to apply;
click Cancel to abort the operation.
If this is applied in the reference ladder well, all samples and the reference
ladder will be updated; if this is applied in a sample well, all sample wells but
not the reference ladder will be updated.
Note: You should only select this option if you wish to apply all settings of
the Advanced Flag tab to the selected set of samples. Any previous
changes to the selected samples of the data file will be overwritten.
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Table 42

Advanced Flag configuration settings

Settings

Description

Save Advanced Flag
Parameters

Saves the current Advanced Flag Analysis settings to a file (*.ACtempt
extension) that can be loaded into different data files. A file browser menu
will open to navigate and save the desired filename and location; click OK to
save the file, or Cancel to abort operation.
Note that this saves the entire plate flag map (which may have different
flag conditions for each different well).
Note: This option saves an entire plate map of different flag conditions to
each well.

Load Advanced Flag
Parameters

Loads previously saved Advanced Flag Analysis settings from a file
(*.ACtempt extension). A file browser menu will open to navigate and load
the desired filename and location; click OK to load the file, or Cancel to
abort operation.
Note that this applies an entire plate flag map. Note: This option applies an
entire plate map of different flag conditions to each well.

Table 43

Criteria Input settings to define a flag condition

Settings

Description

Title

To name the set of conditions being used (which may include several
tags).

Tag

To name an individual flag condition being used.

Value

Defines the numerical value of the unit for the flag condition.

Unit

Drop-down list which defines the units of the condition to flagged. The first
Unit is always size (bp or nt) based; for the second Unit criteria there are
four secondary flagging options:
• bp (size)
• ng/µL (concentration)
• nmole/L (concentration)
• RFU (Relative Fluorescence Units)

Range

Defines the numerical range to use for applying the flag condition. The
drop-down to the left of this field determines the operation to apply:
• ± (will flag the value entered with a plus and minus range)
• > (will flag when greater than the range)
• < (will flag when less than the range)
• = (will flag when equal to the range)
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Table 43

Criteria Input settings to define a flag condition

Settings

Description

Boolean Operation

Drop-down list which defines the Boolean operation to apply to the flag
condition. There are five options to apply:
• ---: No second flag condition is applied.
• AND: Both the first and second flag condition must apply to be true
• OR: First or second flag condition must apply to be true
• AND NOT: The first flag condition must apply and the second must not
apply to be true
• NOR: Both the first and second flag condition must not apply to be true
Adding a Boolean operator at the end of a flag condition allows you to enter
a continuation of flag conditions-enabling complex combinations.

Accept

To accept the flag conditions defined for the individual well

Load

To load an individual set of flag conditions (*.template). Note that multiple
individual flag conditions can be applied to the same well.
For example: 200 bp only; 300 bp AND 500 bp; 600 bp only.

Save

Saves an individual flag condition (*.template). Note that multiple individual
flag conditions can be applied to the same well.
For example: 200 bp only; 300 bp AND 500 bp; 600 bp only.

Cancel

Cancels any information entered and closes the window.

Set Individual Parameters – Inclusion Region
The settings of the Inclusion Region tab allow the user to define up to four size
inclusion ranges (Figure 56). Only peaks (excluding markers) that fall into the
defined range(s) will be displayed. The Inclusion Region will affect the screen
display, PDF reports and exported data. Table 44 describes additional settings
not displayed in Global Configuration dialog.
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Figure 56

Inclusion Region tab in Set Individual Parameters dialog

Table 44

Additional settings in the Inclusion Region tab

Settings

Description

Apply to All

All current settings of just the Inclusion Region tab will be applied to all
samples of the loaded data file. If this is applied in the reference ladder
well, all samples and the reference ladder will be updated; if this is
applied in a sample well, all sample wells but not the reference ladder
will be updated.

Note: You should only select this option if you wish to apply all settings
of the Inclusion Region tab to all samples. Any previous changes made
for the samples of the data file will be overwritten.
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Table 44
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Additional settings in the Inclusion Region tab

Settings

Description

Apply to Selected Samples

Applies all current settings of just the Inclusion Region tab only to any
user specified wells of the sample plate. The Selected Samples plate
map menu will be displayed to select the wells of the sample plate to
apply the settings to. Select desired wells, rows, or columns, and click
OK to apply; press Cancel to abort the operation.
If this is applied in the reference ladder well, all samples and the
reference ladder will be updated; if this is applied in a sample well, all
sample wells but not the reference ladder will be updated.
Note: You should only select this option if you wish to apply all settings
of the Inclusion Region tab to the selected set of samples. Any previous
changes to the selected samples of the data file will be overwritten.
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This chapter describes the size calibration screen (also referred to as calibration
curve screen). The calibration curve screen is used to select the conditions for
calibrating the size of unknown sample peaks/smears.
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About Size Calibration
In the ProSize software, the user can calibrate the size of sample fragments
either by running a standard DNA or RNA ladder in a well of the sample plate
(recommended), or by importing a previously calculated and exported size
calibration file (*.scal extension).

NOTE

If an imported size calibration is used in ProSize, the same separation gel,
capillary array dimensions, injection/run voltage, and lower/upper markers
should be used for both the analyzed data and the imported calibration to ensure
maximum sizing accuracy.
To properly calibrate the size, the size ladder must be bracketed by the same
lower/upper markers used with the samples. In some cases, the lower or upper
marker may co-migrate with a ladder peak; this is acceptable for sizing
calibration. In some application kits (for example, RNA and Genomic DNA kits),
only a lower marker is used; the data is hence normalized using the lower marker
only compared to the respective DNA or RNA Size Ladder.
It is important to ensure the sample containing the size calibration ladder has all
ladder fragments integrated correctly with no additional peaks integrated prior to
analyzing the remaining samples.
The following sections describe how to load, edit and import/export from the
calibration curve screen, and how to identify and correct an improperly calibrated
data file.
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Loading the Size Calibration Curve
The calibration curve can be defined using two methods:
A: When an unprocessed data file is first opened and a matching
configuration is not found, the Global Configuration dialog will appear which
is shown in Figure 57. This is the most common way to define the calibration
curve.

NOTE

In most cases, predefined, optimized global configuration files are available to
load when processing data collected from different Agilent Reagent Kits. The
configuration files are labeled according to the particular kit number, for example,
DNF-910 Kit - Fragment Analyzer.ini. These configuration files are available from
Agilent upon request if needed. The preloaded configuration files are located in
the C:\ProSize data analysis software\Configurations folder.
B: At any time after a file is opened, you can view the Calibration Curve screen
by selecting
from the main screen, or navigating to Analysis > Show Size
Calibration.
The Size Calibration tab in the Global Configuration dialog is shown in Figure 57;
the settings are described in Table 45.
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Figure 57

Size Calibration tab in the Global Configuration dialog

Table 45

Size Calibration settings

Settings

Description

Calibration Ladder

Lists size of DNA/RNA fragments contained in calibration ladder in
tabular format. The size of each fragment (include lower/upper
markers) is entered directly into the table or imported by using the
context menu (right-click in the Calibration Ladder table).

Calibration Ladder >
Insert Before

Inserts a blank cell above the currently selected cell in the calibration
ladder table.
Note: Click in the respective table cell to use this option.

Calibration Ladder >
Delete Current Selection

Deletes the currently selected cell in the calibration ladder table. Note:
Click in the respective table cell to use this option.

Calibration Ladder > Clear
All

Deletes all cells in the calibration ladder table.

Calibration Ladder >
Import

Imports a previously exported and saved sizing ladder information
file. When selected, a file browser menu will open to navigate and
select the desired file (*.txt extension). Standard ladder information
files are located in the C:\ProSize data analysis software\Ladders
folder.
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Table 45

Size Calibration settings

Settings

Description

Calibration Ladder >
Export

Exports the current sizing ladder table information (*.txt extension).
When selected, a file browser menu will open to navigate and save the
desired filename and location. When exporting ladder information
files, it is highly recommended to save the created files to a common
directory, located in the C:\ProSize data analysis software\Ladders
folder.

Default Ladder Well

Defines the well of the sample plate, which contains the size
calibration ladder. From the drop-down list, select the proper row
(A-H) and column (1-12) location containing the size calibration
ladder.

Curve Fitting

• Point to Point
Fits the size calibration plot of Size (bp or nt) vs. Time (sec) with a
Point to Point fit (recommended), drawing a straight line between
each point of the curve.
• Polynomial
Fits the size calibration plot of Size (bp or nt) vs. Time (sec) with a
polynomial fit. Enter the order value (from 3 to 5) in the Order field.

Use Imported Ladder
Profile

Imports a previously exported size calibration file (*.scal extension) to
use for size calibration.

Ladder Profile

Displays file path for the imported size calibration file. To load an
imported file, click
. A file browser menu will open to navigate and
select the desired file (*.scal extension).
Note: When importing a size calibration file, the same conditions
(separation gel, capillary array length, lower/upper markers, CE
separation voltage) should be used. Differences between the
analyzed and imported conditions will adversely affect the sizing
accuracy.
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Define Calibration Ladder
The size of each fragment to be included in the DNA/RNA Ladder (including
lower/upper markers) is listed in the Calibration Ladder table (see Figure 57). You
can enter directly a value into table or use the Import command of the context
menu (right-click in the table). Table 45 describes the commands of the context
menu, which include inserting or deleting fragments, clearing all entries, and
importing or exporting ladder information files (*.txt extension).

NOTE

In most cases, predefined ladder information files optimized for different Agilent
Reagent Kits are available and are loaded as part of the global configuration. The
ladder files are labeled according to the particular kit number, for example,
DNF-910-33 - 35-1500bp.txt. These ladder files are available from Agilent upon
request if needed. The preloaded ladder files are located in the
C:\ProSize data analysis software\Ladders folder.

Define Default Ladder Well
If a size ladder is contained in the sample plate, the sample well for the ladder is
displayed in the Default Ladder Well field (see Figure 57, Table 45). Click in the
field, and from the drop-down list, select the proper well row (A, B, etc.) and well
column (1, 2, 3 etc.) of the well containing the sizing ladder. When processing
12-capillary data, only the well column field (1-12) is selectable.

Define Curve Fitting
The Curve Fitting drop-down menu allows you to define how the size calibration
curve is fitted - via a Point to Point or Polynomial Fit (3rd to 5th order) (see
Figure 57, Table 45).

NOTE

It is highly recommended to use Point to Point when fitting the size calibration
curve. All standard methods use this setting.

Use Imported Ladder
To use your previously exported size calibration settings, select Use Imported
Ladder (see Figure 57). To import your file, select
. A file browser menu will
open to navigate and select the desired file (*.scal extension) (Figure 57,
Table 45).
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Peak Analysis for Reference Cap
The default ladder well is considered to be the “Reference capillary“. When
loading the configurations (for example, for an unprocessed file), note that a
separate tab labeled Peak Analysis for Reference Cap is available (Figure 58).
This tab enables you to enter independent peak settings to properly identify the
DNA/RNA Ladder peaks as compared to the sample peaks, as outlined in
Table 46.
Further information on these settings is available in Chapter 4, “ProSize
Configuration”. When loading or editing the settings of the global configurations,
it is important to set these parameters properly to ensure the ladder peaks are
selected correctly for size calibration.

Figure 58

Peak Analysis for Reference Cap tab in the Global Configuration dialog

Table 46

Peak Analysis for Reference Cap configuration settings

Settings

Description

Peak Analysis
Peak Width (sec)

ProSize Data Analysis Software User Manual

Defines the width threshold for peak detection in
seconds. Higher settings better define wide peak
start/end points; smaller settings better define
sharp peak start/end points. For DNA/RNA
Ladders, the typical value ranges from 3-5.
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Table 46

Peak Analysis for Reference Cap configuration settings

Settings

Description

Min. Peak Height (RFU)

Defines the minimum peak height threshold to
select a peak for integration in RFUs. Peaks below
the set value will not be selected for integration.

# Extra Valley Points

This setting affects the start/end point of baseline
integration of peaks and the baseline drawn
between peaks. This setting most affects the
baseline between two peaks that are not baseline
resolved. Higher values draw a straighter baseline
between the first peak start point and second peak
end point; lower values draw the baseline more to
the "valley" between the two unresolved peaks.
Note: The Valley to Valley Baseline? setting needs
to be enabled for this function to be active.
A typical setting for a DNA Ladder is 3; for a RNA
Ladder this is typically set to 0.

Valley to Valley Baseline?

This setting affects the start/end point of baseline
integration of peaks and the baseline drawn
between peaks. This setting most affects the
baseline between two peaks that are not baseline
resolved. When disabled, will draw a straighter
baseline between the first peak start point and
second peak end point. When enabled, will draw the
baseline more to the "valley" between the two
unresolved peaks.
This setting is typically enabled for a DNA Ladder
and disabled for a RNA Ladder.

Once the proper Calibration Ladder fragments, Default Ladder Well, and Curve
Fitting algorithm have been selected (or previous calibration imported) and the
correct Peak Analysis for Reference Cap settings have been loaded, along with the
other configuration settings, the file is loaded into the ProSize software.
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Viewing and Exporting the Size Calibration (File Open)
Once a data file is loaded into the ProSize software, if the size calibration ladder
is contained within the sample plate its well location will be marked with a light
blue color (Figure 59, well H12 highlighted with a blue circle). To view the ladder
well, click on the respective well in the Plate Map.

Figure 59

Main screen: The Size Calibration well H12 is marked in blue in the Plate Map (circled in blue to
highlight position of reference capillary). Note: the ladder is selected properly (no error
message).

If the number of integrated peaks in the reference well matches the number of
fragments in the Calibration Ladder table, the size calibration curve will be fitted
with the selected Curve Fitting algorithm and the corresponding calculated sizes
will be reported for each sample. The bottom task bar of the ProSize software will
display the file path and no errors will be displayed (Figure 59).

NOTE

It is generally recommended to inspect the size calibration well as well as the
calibration curve screen prior to processing or exporting data, to ensure the
desired fragments/markers are selected properly.
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To view the size calibration curve from the main screen of the ProSize software,
click
in the main screen, or navigate to Analysis > Show Size Calibration. The
calibration curve screen will be displayed (Figure 60).

Figure 60

Figure Calibration Curve screen showing properly selected size calibration ladder

The size calibration curve is a plot of Time vs. Size in upper left corner. A proper
fit is characterized by the red fit line passing through each blue data point as
closely as possible. In most cases, the Point to Point algorithm provides the best
fit to the data. However, in some situations the Polynomial algorithm may provide
smoother, more continuous fit in the higher size region.
The functions in this screen are the same as in the Size Calibration and Peak
Analysis for Reference Cap tabs in the Global Configuration dialog (Figure 57 and
Figure 58).
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•

The Calibration Ladder table and its context menu functions, and the
Default Ladder Well, Curve Fitting, and Use Imported Ladder Profile functions
are described in Table 45.

•

The Peak Analysis panel enables adjustments to be made to the peak
integration settings of calibration ladder; these functions are the same as
those summarized in Table 46.
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In the calibration curve screen also an Electropherogram Trace (bottom) of the
calibration ladder well is displayed. The toolbar of the trace enables you to zoom,
autoscale, copy or view the start/end points of each peak as summarized in
Table 47. The functions of the Electropherogram Trace context menu enable you
to modify and adjust the selected peaks in the selected reference well as needed
to match those present in the Calibration Ladder table (Table 47).
You can export the currently viewed size calibration by selecting Export.
Table 47

Calibration Curve screen additional functions

Item

Description

Apply

Applies the current size calibration settings and exit to the main
screen of the ProSize software. Any changes made from the
initially opened Calibration Curve screen will be applied to the
data.

Export

Exports the current size calibration settings and fitted
electropherogram/plot, which can be imported to other similarly
generated data files (*.scal extension). A file browser menu will
open to navigate and save the desired filename and location.

Cancel

Closes the Calibration Curve screen and exit to the main screen of
the ProSize software. Any changes made from the initially opened
Calibration Curve screen will not be applied to the data.

Zoom

Enables zooming-in on any portion of the Electropherogram
Trace. To zoom-in, click the icon and position the mouse cursor
over desired starting position; click and drag the cursor to the
desired location, and release the mouse button.

AutoFit

To autoscale the Electropherogram Trace x-/y-axis view.

Copy

Copies an image of the Electropherogram Trace to the clipboard,
for pasting in another program such as Microsoft PowerPoint.

Show Peak Start/End Edge

Toggle to display or hide the start and end points used for peak
integration, shown as vertical orange lines.
Displaying the peak integration start/end points can aid in
determining if adjustments need to be made to the peak
integration to better define the actual peak area. The user can
change the peak start/end points by adjusting the Peak Width
(sec), or by using the context menu of the Electropherogram
Trace such as Split Peak or Move Peak Start/End Points.

Accept Change

Accepts any manual modification to the peak integration (Add
Peak, Split Peak, Merge Peaks, Delete Peak, Move Peak
Start/End Points). After the manual modification has been made,
right-click the Electropherogram trace, and select Accept Change.
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Table 47
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Calibration Curve screen additional functions

Item

Description

Cancel

Cancels any manual modification to the peak integration (Add
Peak, Split Peak, Merge Peaks, Delete Peak, Move Peak
Start/End Points). After the manual modification has been made,
right-click the Electropherogram trace, and select Cancel.

Add Peak

To manually add a peak which has not been auto-integrated by
the Peak Analysis settings and to define the start and end point
for integration.
Zoom-in to the region where the peak is to be added. Right-click
this region and select Add Peak. Two red vertical cursors will
appear; the left cursor defines the new peak start point and the
right cursor the new peak end point. Drag each cursor to the
desired position, then right-click, and select Accept Change to add
the peak for integration.
Note: The Add Peak function will not add a peak that is located
outside the lower/upper marker window (or before lower marker if
using only lower marker).

Split Peak

To manually split a peak which is currently integrated into two
peaks and to define where the split occurs.
Zoom-in to the region where the peak is to be split. Right-click this
region, and select Split Peak. A red vertical cursor will appear.
Drag the cursor to the desired location, then right-click, and select
Accept Change to split the peak into two peaks for integration.

Merge Peaks

To merge any number of peaks and integrate as a single peak.
Zoom-in to the region where the peak is to be split. Right-click this
region, and select Merge Peaks. Two red vertical cursors will
appear; the left cursor defines the left most peak to merge and
right cursor defines the right most peak to merge. Drag the cursor
within that peak’s start/end point region to merge, then right click,
and select Accept Change to merge the peaks into a single peak
for integration.
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Table 47

Calibration Curve screen additional functions

Item

Description

Delete Peak

To manually delete a peak which has been integrated.
Zoom-in to the region where the peak is to be deleted. Right-click
this region, and select Delete Peak. A red vertical cursor will
appear. Drag the cursor to the desired peak location, then
right-click, and select Accept Change to delete the peak from the
integration.

Move Peak Start/End Points

To change the currently positioned start/end integration points of
a peak.
Zoom-in to the region where the peak is located. Place the cursor
between the start and end points of the integration. Right-click
and select Move Peak Start/End Points. Two red vertical cursors
will appear at the current start/end points. Drag the cursors to the
desired locations, then right-click and select Accept Change to
apply the new start/end point positions to reintegrate the peak.
Note: This function will not change the baseline; only the start and
end points are affected. To change the baseline, the user must
adjust the via the Peak Width (sec), Valley to Valley, or Manual
Baseline Setpoints tools.
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Identifying and Correcting an Improper Size Calibration
When performing the size calibration, the ProSize software will attempt to fit the
integrated peaks in the size calibration well to the fragments listed in the size
Calibration Ladder table. If the number of integrated peaks in the ladder well does
not match the number of fragments in the size Calibration Ladder table (either
less or more peaks integrated), a red flashing error message will appear at the
bottom of the main screen: Warning: Mis-match between detected peaks and
ladder assignment! No sizing calibration curve is established.
An example of less integrated peaks than calibration fragments is shown in
Figure 61 and Figure 62 an example of too many integrated peaks is shown in
Figure 63 and Figure 64. In each case, you need to adjust the Peak Analysis
settings either in the main screen configuration tab, or in the calibration curve
screen, to select the proper number of peaks in the size calibration ladder well
(including lower/upper markers) to achieve the proper size calibration. Once the
proper number of peaks is selected, click the Apply button. The bottom task bar
of the ProSize software will then display the file path with no errors.

Figure 61
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Main screen showing improperly fitted size calibration (not enough integrated peaks). Solution
to correct: In the Peak Analysis table lower the Min. Peak Height (RFU) threshold to integrate
missing peak (circled in blue).
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Figure 62

Calibration Curve screen showing improperly fit size calibration from Figure 61.
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Figure 63
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Main screen showing improperly fitted size calibration (too many integrated peaks, circled in
blue). Solution to correct: increase the Min. Peak Height (RFU) threshold to no longer integrate
extra peaks.
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Figure 64

Calibration Curve screen showing improperly fit size calibration from Figure 63
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This chapter gives an overview of the possible ways to compare samples in the
ProSize software.
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Overlay Options
There are two options for comparing samples: The Quick Overlay and the Overlay
Samples screen.

Quick Overlay
1 Right-click the sample on the gel image you want to overlay.

The overlay images appear in the electropherogram area.

2 Be sure to select the desired Normalize icon (for example, Normalize to Lower
Marker) to get an accurate representation of how the samples compare with
each other.
3 To end the Quick Overlay view, double-click on any lane of the gel image.
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Overlay Samples Screen
The Overlay Samples screen is used to overlay and generate comparisons, in
digital gel view and electropherogram view, of selected samples from the
currently opened data file and optionally from different data files (when using the
same markers and experimental conditions), and generate reports of the overlaid
data.
Once the Overlay Samples screen is opened, all results are handled and saved as
Projects. Before you can export data or generate a .pdf report, the results of the
overlay plots must be saved as a Project. Previously saved projects can be
opened via the menu Project tab.
The following sections describe how to open, select data to overlay,
adjust/annotate overlaid data, open additional data files, and copy/export
information from the Overlay Samples screen.

Opening the Overlay Samples Screen
1 To view the Overlay Samples screen from the main screen, select
navigate to Analysis > Overlay Samples.

or

The Overlay Samples screen is displayed (Figure 65). Table 48 summarizes
the top menu bar functions.

Figure 65
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Overlay Samples screen (no samples selected)
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Table 48

Overlay Screen top menu functions

Menu Item

Description

Project…Load

Opens a previously saved overlay project.

Project…Save

Saves the current overlay project.
Note: The user must save an overlay project before the export or
“generate report” icons are active.

Project…Save As

Saves an additional copy of the overlay project without replacing
the original.
Note: The user must save an overlay project before the export or
“generate report” icons are active.

Project…Create

Creates a new overlay project. This re-opens the overlay file with a
blank screen.

View Data File

To temporarily exit the overlay screen to view the data file. To
return to the overlay screen, select Project….Return to Project.

Table 49 summarizes the available functions in the screen prior to opening any
sample wells. A Plate Map menu is visible in the top left corner for selection of
samples to overlay; the sample filename is listed at the top of the menu.
Table 49

Overlay Samples screen functions (no samples selected)

Menu Item

Description

Open File

When selected, a file browser window opens for locating and
opening an additional raw data file (*.raw extension) for data
analysis comparison to the currently opened data file.
Note: If multiple files are to be opened for comparison in the
Overlay Samples screen, to generate a meaningful comparison,
the additional opened files should:
• Be previously processed in the ProSize software (i.e., markers
selected, size calibrated).
• The same lower/upper markers must be used.
• Similar experimental conditions (separation gel, array length,
separation voltage) must be used.

Exit Overlay Samples

Closes the Overlay Samples screen and returns to the main screen
of the ProSize software.

Default Layout

Shows an “overlay of samples” using both the electropherogram
and digital gel view in the same window)(Figure 68).

Image Layout

Shows an “overlay of samples” using a digital gel image window
only (Figure 69).

Trace Layout

Shows an “overlay of samples” using an electropherogram trace
window only (Figure 70).
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Table 49
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Overlay Samples screen functions (no samples selected)

Menu Item

Description

Generate Report

Generates a PDF report of the Overlay Samples (see Figure 71).
Each file will be color coated. Report options are discussed in
detail in Chapter 8, “Generating Reports from ProSize”. Data will be
color coded per separation. Note: A project must be saved before
the program allows you to generate a report.

Export Data

Exports data from the Overlay Samples (see Figure 72). Export
options are discussed in detail in Chapter 7, “Exporting Data from
ProSize”. Data will be color coded per separation.
Note: A project must be saved before the program allows you to
export data.

Plate Map

Used to select a sample well(s) for comparison.
To select well(s), click the well to add to the overlay; click a second
time to remove (in any order). To add/remove a column, click the
corresponding column number (1, 2, etc.). To add/remove a row,
click the corresponding row letter (A, B, etc.). To select/remove all
wells of the plate, select the well in the upper left corner of the
plate. The sample filename is displayed at the top of the Plate
Map.

ProSize Data Analysis Software User Manual

6

ProSize Overlay Samples
Overlay Samples Screen

Table 49

Overlay Samples screen functions (no samples selected)

Menu Item

Description

Sample ID navigation

When selected, a Sample ID list will slide out (Below), enabling the
User to select the samples for overlay by the Sample ID previously
entered into the instrument software.
To select a sample, click the sample name; that well will be
highlighted. To remove a well, click it a second time. To clear all
wells, right-click and select Clear All. To close the Sample ID
navigation, click the arrow at the bottom right of the panel.

Information

When selected, a window opens displaying the instrument
software user interface, containing experimental information and
notes fields.
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Once sample wells are selected in the Overlay Samples screen, they are
displayed in order of selection from left to right on the digital gel view and from
bottom to top on the electropherogram trace view (Figure 66). If 24 samples are
selected the Sample ID will be shown above the gel view, if more than 24
samples are selected the Sample ID will not be shown.
In the digital gel view, each sample/lane selected is annotated at the top by well
ID and sample name; the currently opened data file is labeled with a (1) to signify
it is the first file open. Additional data files if opened will have their samples/lanes
labeled with (2), (3), etc. The side axes for the digital gel image are labeled by size,
corresponding to the size calibration ladder. On the right side of the digital gel
image, a slider bar is present allowing the adjustment of the intensity/contrast of
the image by left clicking and dragging the bar.
In the electropherogram trace overlay, each sample is displayed in a different
color with matching color annotation to the right of the overlay by well ID and
sample name; the currently opened data file is labeled with a (1) to signify it is the
first file open. Additional data files if opened will have their samples/lanes labeled
with (2), (3), etc. The x-axis is labeled by Size and the y-axis by RFU in the trace
overlay. On the right side of the electropherogram trace overlay, a slider bar is
present to adjust the vertical spacing between traces by left clicking and
dragging the bar.

Figure 66
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Overlay Samples screen (24 samples selected)
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Display, Annotation and Export Options in the Overlay Samples Screen
Toolbar functions are available in the Overlay Samples screen for both the digital
gel view and electropherogram trace overlays to adjust the display, annotate
samples, and export results. These functions are summarized in Table 50.
To access the toolbar functions of the digital gel view overlay, click the
corresponding icons (Figure 67). For the electropherogram trace overlay, in
addition to the toolbar, a context menu is also available.

Figure 67

Overlay Samples screen (digital gel image toolbar and electropherogram trace with context
menu)

Table 50

Overlay Samples toolbar and context menu commands (samples selected)

Menu Item

Description

Digital Gel Image Toolbar
Copy Full Gel Image

Copies an image of the current 24 lane digital gel view overlay to the
clipboard, for pasting in another program such as Microsoft
PowerPoint. Any zoom, image normalization, or annotation will be
copied in the image. The well ID and sample name will be copied on
the top of each lane, and the y-axis will correspond to the currently
selected size range obtained from the size calibration ladder in the
copied image.
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Table 50
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Overlay Samples toolbar and context menu commands (samples selected)

Menu Item

Description

Show/Hide Cursor

Displays a horizontal line cursor across the digital gel image overlay,
annotated by size (bp or nt) corresponding to the current position. The
cursor can be dragged to any position along the gel image by clicking
the cursor and holding the mouse button.
When the cursor is active and displayed, a similar vertical cursor
annotated by size is displayed in the electropherogram trace overlay,
whose movement corresponds to that in the gel image.
To deactivate the cursor, click the icon a second time.

Zoom

Enables zooming in the y-axis (Size) of the digital image overlay.
To zoom-in: Place the mouse over the trace, click and drag it outward
to expand a box area to define the zoom region. Release the mouse
button to apply. The zoomed image can be copied to the clipboard.

AutoFit

To autoscale the digital gel image overlay y-axis view for all 24
currently viewed lanes. The autoscaled image will display the gel from
the selected lower marker to upper marker, or if only a lower marker is
used from the lower marker to the end of the separation window.

Auto Intensity

To autoscale the intensity of the digital gel image overlay. The viewed
intensity across the image will reflect the actual observed
fluorescence signals from each lane.

Normalize Intensity to Lower
Marker

To normalize the intensity of the digital gel image overlay lower
marker for each lane to the same value, adjusting the relative
intensities of all bands in each lane accordingly. The viewed intensity
across the image will as a result reflect the fluorescence signals from
each lane after normalization to the lower marker, as is done when
calculating the concentration of samples using the lower marker.

Normalize Intensity to Upper
Marker

To normalize the intensity of the digital gel image overlay upper
marker for each lane to the same value, adjusting the relative
intensities of all bands in each lane accordingly. The viewed intensity
across the image will as a result reflect the fluorescence signals from
each lane after normalization to the upper marker, as is done when
calculating the concentration of samples using the upper marker.

Gel Image Color

Changes the color scheme for the Digital Gel View, the gel image in
the Overlay Samples screen and any exported or printed report.
Options for the gel image color:
• White on Black (white bands on black background)
• Black on White (black bands on white background)
• Green on Black (green bands on black background)
• Red on Black (red bands on black background)
• Pseudo Color (green to red bands on blue background)
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Table 50
Menu Item

Overlay Samples toolbar and context menu commands (samples selected)
Description

Electropherogram Trace Overlay Toolbar
Zoom

Enables zooming in the x-and y-axis of the Electropherogram Trace.
To zoom-in: Place the mouse over the trace, click and drag it outward
to expand a box area to define the zoom region. Release the mouse
button to apply. The zoomed image can be copied to the clipboard.
The zoom region will be preserved when viewing other samples in the
Plate Map. To undo the zoom, use the Autoscale function.

Drag

Enables dragging in the x-and y-axis of the Electropherogram Trace.
To drag: Place the mouse over the trace, click and drag it in any
direction, and release the mouse.

Autoscale

To autoscale the Electropherogram Trace x-/y- axis display. The
autoscaled image will display the full trace from the start to the end of
the separation when using the Time Scale and Size Scale display
modes; when using the Uniform Size Scale, the autoscaled display
will start at 0 bp.
Note: The y-axis scale will automatically zoom to the highest detected
sample peak, regardless of the marker peak heights. To view the
entire y-axis scale including markers, go to Option, and select
Autoscale as the Display Mode.

Copy

Copies an image of the current view of the Electropherogram Trace to
the clipboard, for pasting in another program, such as Microsoft
PowerPoint. Any zoom, annotation, baseline and/or peak start/end
point displayed will be copied in the image. The well ID and sample
name will be copied in the top left of the trace, and the x-/y-axis will
correspond to the currently selected view in the copied image.

Units

Displays a menu for changing the peak annotation of the
Electropherogram Trace. Only integrated peaks are annotated.
Units for the peak annotation:
• None
• Peak ID (labels in order as 1, 2, etc.)
• Migration Time (min:sec) raw migration time
• Peak Height (in RFUs)
• Corrected Peak Area (Peak Area/Migration Time)
• Size (in bp or nt)
• Average Size (in bp or nt)
• Concentration (in ng/µL)
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Table 50

Overlay Samples toolbar and context menu commands (samples selected)

Menu Item

Description

Create Annotation

To create customized annotation in the Electropherogram Trace
display. In the Add Annotation dialog, the user can type desired
annotation into the field. Click OK and the annotation will be displayed
in the Electropherogram Trace window.

To move the annotation to the desired position on the trace: Click the
annotation and drag it to the desired position. An arrow will appear at
the opposite end of the annotation upon dragging.
Multiple annotations can be created by repeatedly selecting Create
Annotation. Any created annotations will be copied to the clipboard
with the Copy function.
Edit Annotations

Opens the Annotation Editor window. Allows the user to:
• Edit the annotation text by typing in the text field.
• Change the color of the annotation by left clicking on the
annotation color.
• Delete one annotation by selecting Delete next to each annotation,
or delete all annotations by selecting Delete All.

Select Apply to confirm your settings.
Electropherogram Trace Overlay Context Menu
Copy Image to Clipboard
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Copies an image of the current view of the Electropherogram Trace to
the clipboard, for pasting in another program, such as Microsoft
PowerPoint. Any zoom, spacing, or annotation displayed will be
copied in the image. This function operates similar to the Copy icon
function.
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Table 50

Overlay Samples toolbar and context menu commands (samples selected)

Menu Item

Description

Export Data to Clipboard

To copy the electropherogram x-data (time; in seconds, starting with
the lower marker) and y-data (RFUs) in a .csv format that can be
pasted directly into common spreadsheet programs such as
Microsoft Excel. The x-data is copied into the first column, and the
y-data into the second column of the file from left to right starting with
the bottom- most sample upon pasting. The columns are annotated
starting with Plot 0, 1, 2, etc. in order.
To export, right-click to display the context menu and select Export
Data to Clipboard. Then open spreadsheet, position in desired cell
and paste into the program; process and save as desired.

Export Data to Excel

This function requires Microsoft Excel to be installed on the computer
to function properly. Selection will automatically open Microsoft Excel
and copy each overlaid electropherogram x-data (time; in seconds,
starting with the lower marker) and y-data (RFUs) in a .csv file format.
The x-data is copied into the first column, and the y-data into the
second column of the file from left to right starting with the bottommost sample upon pasting. The columns are annotated starting with
Plot 0, 1, 2, etc. in order.
To export, right-click to display the context menu, and select Export
Data to Excel. The file can then be processed and saved as desired.

Create Annotation

To create customized annotation in the Electropherogram Trace
display. In the Add Annotation dialog, the user can type desired
annotation into the field. Click OK and the annotation will be displayed
in the Electropherogram Trace window.

To move the annotation to the desired position on the trace: Click the
annotation and drag it to the desired position. An arrow will appear at
the opposite end of the annotation upon dragging.
Multiple annotations can be created by repeatedly selecting Create
Annotation. Any created annotations will be copied to the clipboard
with the Copy function.
Clear All Annotations

Clears your created annotations from the electropherogram trace
overlay display.
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Displaying Multiple Files in the Overlay Samples Screen
Several different data files can be simultaneously opened and compared using
the Overlay Samples screen in ProSize.
To compare different data sets, several criteria should be met when overlaying
multiple files:
•

The data must use the same size lower/upper marker combination. For RNA
analysis, the same lower marker should be used.

•

Any additional data files opened in the Overlay Samples screen should be
previously processed, with the lower/upper markers correctly selected for the
data and the size calibration correctly performed. No additional processing
can be done on the opened comparison files; only adjustments to the
intensity/spacing can be made.

•

The experimental conditions should ideally be the same or similar for both
sets of data, using the same separation gel, array length, separation voltage,
and/or assay type (for example, NGS Kit).

With the currently open data file displayed in the Overlay Samples screen, select
to open a second data file. A file browser menu will be displayed for locating
and opening the additional raw data file (*.raw extension). Once opened, a
second Plate Map will be displayed for the second data file below the original file,
labeled at the top with the filename (Figure 68).
All functions apply the same to the second opened data file compared the first; to
close the second data file at any time, click
in the upper right corner of the
Plate Map.
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Figure 68

Overlay Samples screen displaying two different data files open
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Alternate Views in the Overlay Samples Screen
Several different views can be displayed in the Overlay Samples screen as
described in Table 49. Figure 69 shows the Image Layout view; Figure 70 shows
the Trace Layout view. The functions in these screens are the same as those in
the Default Layout view.

Figure 69
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Overlay Samples screen displaying Image Layout view
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Figure 70

Overlay Samples screen displaying Image Layout view
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Figure 71
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Overlay Samples PDF Report showing the first page of overlayed traces page, Traces Summary
page, and Electropherogram/Peak Table page
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Figure 72

Export folder showing files generated from the Overlay Samples screen
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This chapter provides an overview of the options available for exporting
processed data from the ProSize software. The following sections describe how
to open the Export Data window; provide an outline of various data export
options; describe how to perform data export; and give examples of exported
data.
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Export Data Utility
Once the data is opened and processed within the ProSize program, the
measured/calculated information can be exported in common formats for
storage in a common database or for use in other programs.
Export Data is used to export information from the ProSize program.

Export Data Window Settings
To export sample results from the ProSize software:
1 From the main screen, select

, or navigate to File > Export Data.

The Export Data window will be displayed (Figure 73).

Figure 73
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Export Data window
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Table 51 summarizes the available settings in the Export Data window.
Table 51

Export Data settings

Settings

Description

Sample Option

Determines which samples of the data file will have information
exported. There are two options: All Samples (results for all samples
of data file exported); and Selected Samples. The Selected Samples
option will open the Selected Samples window.

Select the respective wells, columns and/or rows of the sample
plate, and click Apply. To abort the operation and export all samples,
click Cancel.
Export All

Exports all fields of the Export Data utility for the data file.

Peak Table – Standard or
Alternate

Standard: Exports the Peak Table for all selected samples as a
single .csv file, listed in order of sample well (Figure 75).
Alternate: Exports the Peak Table for all selected samples as a
single .csv file, listed in rows (Figure 76).

Smear Analysis Table

Exports the Smear Analysis table for all selected samples as a single
.csv file, listed in order of sample well (Figure 77).
If no data is present in the Smear Analysis table, this function will be
disabled.

Flag Analysis Criteria Table –
Standard or Alternate

Standard: Exports the Flag Analysis table for all selected samples as
a single .csv file, listed in order of sample well (Figure 78). The output
will be in a binary 0/1 format, with each column labeled by the
respective Flag condition.
Alternate: Export the Flag Analysis table for all selected samples as
a single .csv file, listed in order of sample well) (Figure 79). The
output will list the values within the set criteria of the Flag analysis by
row.
If no data is present in the Flag Analysis table, this function will be
disabled.

Advanced Flag Criteria Table

Exports the Advanced Flag Analysis table for all selected samples
as a single .csv file, listed in order of sample well (Figure 80). The
output will lists the values for the configurations of the Advanced
Flag analysis by row.
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Export Data settings

Settings

Description

Electropherogram – Exports as
CSV File

Exports electropherogram data in a .csv file format.

File Export Option

Determines how electropherogram .csv data is exported.
When Single File is selected, will export all electropherograms
together in a single file, with the x-axis in the first column and each
sample result’s y-axis data in separate columns increasing from left
to right (Figure 81).
When Separated Files is selected, will export each electropherogram
as a separate file, with the x-axis in the first column and the y-xis data
in the second column (Figure 82).

X Axis Scale Option

Determines how electropherogram .csv data is formatted in x-axis.
When Size Scale is selected, will export x-axis data as size, starting
with 0 (Figure 81).
When Time Scale is selected, will export x-axis as time, starting with
0 seconds (Figure 82).

Size Calibration Data

Exports the Size Calibration information as a .csv file, with column 1
as Ladder Size and column 2 as Time (sec) (Figure 83).

Exports Selected Samples Digital
Gel Image

Exports a digital gel image overlay of the selected samples as an
image file, in the format specified (.bmp, .jpg, or .png).

Image Format for
Electropherogram and Gel

Determines which image file format is used for exported
electropherogram images and digital gel image overlay (Figure 84).
There are three different image file format options:
• BMP (.bmp extension)
• JPEG (.jpg extension)
• PNG (.png extension)

Show Annotation

Shows any annotation(s) made to the sample wells on Digital Gel
Image.

Export File Path

Determines the file path for saving exported data. The default
directory is the same folder that contains the .raw data file
(recommended).
To select an alternative directory, click the folder icon. In the file
browser menu, navigate to the desired directory, and save the file.
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Table 51

Export Data settings

Settings

Description

Export

Exports the data file with the settings made.
In the dialog Export Complete, select Open Folder Now to open the
directory. Click Close to close without opening the export folder.

Cancel

Cancels the export operation and returns to the main screen of the
ProSize software.
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Examples of Exported Data
When exporting data from ProSize, the exported files will be named by the .raw
file name followed by an extension dependent upon the information exported
(Figure 74 and Table 52).

168

Figure 74

Exported data showing file name conventions

Table 52

Exported data naming conventions

Exported Item

Description

Peak Table

Filename Peak Table
Example: 2013 07 15 18H 29M Peak Table

Size Calibration

Filename Size Calibration
Example: 2013 07 15 18H 29M Size Calibration

Smear Analysis

Filename Smear Analysis Result
Example: 2013 07 15 18H 29M Smear Analysis Result

Flag Analysis Result

Filename Flag Analysis Result
Example: 2013 07 15 18H 29M Flag Analysis Result

Advanced Flag Analysis Result

Filename Advanced Flag Analysis Result
Example: 2013 05 08 16H 02M Advanced Flag Analysis
Result

Selected Samples Gel Image

Filename Gel
Example: 2013 07 15 18H 29M Gel
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Table 52

Exported data naming conventions

Exported Item

Description

Individual Electropherogram Gel Image

Filename <Well ID> <Sample Name>
Example: 2013 07 15 18H 29M H1 SampH1

Individual Electropherogram Data (CSV)

• If exported as one file:
Filename Electropherogram
Example: 2013 07 15 18H 29M Electropherogram
• If exported as individual files:
Filename <Well ID> <Sample Name>
Example: 2013 07 15 18H 29M H1 SampH1
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The following figures show examples of typical exported data formats:
•

170

Peak Table

Figure 75

Exported Peak table - Standard file format

Figure 76

Exported Peak Table - Alternate file format
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•

NOTE

Smear Analysis

When multiple Smear Analysis conditions are entered for a sample, separate
lines will be created in the exported table. The DNA Quality Number (DQN) along
with the associated size threshold are also shown in the exported Smear
Analysis data. More information is available in Chapter 4, “ProSize
Configuration”.

Figure 77

Exported smear Analysis file format
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•
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Flag Analysis Criteria Table

Figure 78

Exported Flag Analysis - Standard file format

Figure 79

Exported Flag Analysis - Alternate file format
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•

Advanced Flag Analysis Criteria Table

Figure 80

•

Exported Advanced Flag Analysis

Electropherogram CSV – Single File – Size Scale

Figure 81

Exported Electropherogram CSV Single File – Size Scale file format
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•

Electropherogram CSV – Separated Files – Time Scale

Figure 82

•

Size Calibration

Figure 83

174

Exported Electropherogram CSV Separated Files – Time Scale file format

Exported Size Calibration file format
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•

Selected Samples Gel Image

Figure 84

Exported Selected Samples Gel Image file format
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•

Individual Electropherogram Image

Figure 85
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Exported Individual Electropherogram Image file format
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Examples of Generated Reports 182

This chapter provides an overview of the options available for generating reports
from the ProSize software. The following sections describe how to open the
Generate Report window; provide an outline of various report generation options;
describe how to perform the report generation; and give examples of reported
data.
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Generate a Report
Generate a report of sample results
The ProSize software can generate PDF formatted reports for convenient
viewing of processed data, reporting detailed information for each sample
analysis. The Generate Report command is used to generate PDF formatted
results.
1 From the main screen, select

, or navigate to File > Generate Report.

The Generate PDF window opens (Figure 86). Table 53 summarizes the
available settings of this window.

Figure 86
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Generate PDF window
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Table 53

Generate PDF settings

Settings

Description

Sample Option

Determines which samples of the data file will be included in the report.
All selected samples will be saved in a single PDF report file; each
sample will be printed on a separate page of the report.
There are two options: All Samples (results for all samples of data file
exported); and Selected Samples. The Selected Samples option will
open the Selected Samples window.

Select the respective wells, columns and/or rows of the sample plate,
and click Apply. To abort the operation and export all samples, click
Cancel.
Run Summary

A summary of run information will be printed on the first page of PDF
report including Filename and Data Path; date Created; # of Capillaries;
Array Serial #; capillary Effective Length; Array Usage Count; Version #
of software; Device Serial # (Figure 87).
If this is not selected, these fields will be blank.

Method Detail

Details of the performed experimental method will be printed on the first
page of the PDF report (from the user interface Information file ( in
ProSize Plate Map)). If not selected, these fields will be blank.
An example for the Fragment Analyzer is shown below:
Method Information:
Method Name: DNF-493-33 – HS Large Fragment.mthds
Gel Prime: No
Full Conditioning: Yes
Gel Prime to Bufer: Yes
Gel Selection: Gel 1
Perform Prerun: 6.0 kV, 30 sec.
Rinse: No
Marker 1: No
Rinse: Tray: 3, Row: H, # Dips: 1
Sample Injection: 5.0 kV, 30 sec.
Separation: 6.0 kV, 50.0 min.
Tray Name: Tray-1
Analysis Mode: NGS
NOTE
Testing
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Table 53
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Generate PDF settings

Settings

Description

Traces Summary

The Trace Summary page will be printed with up to 12
electropherograms per page (Figure 88). Traces will show the Sample
ID information for each trace.
If not selected, these field will be blank.

Peak Table

For all selected samples, the Peak Table will be printed on each sample
result page in the PDF report (Figure 89). If not selected, this field will be
blank.
Select
to define the reported items and their order in the table. You
can save these settings for future use.

Electropherograms

For all selected samples, the Electropherogram Trace will be printed on
each sample result page in the PDF report. Shown are the peaks with
the currently selected annotation and x-axis scale in ProSize at the time
of printing (Figure 89). The digital gel image will be displayed to the right,
labeled by size.
If not selected, this field will be blank.

Flag Analysis

For all selected samples, a Flag Analysis results table will be printed on
a separate page in the PDF report, with one page per Flag condition
(Figure 90). The output will be in a binary 0/1 format, with each page
column labeled by the respective Flag condition.
If no Flag Analysis table is present for the data file, this option will be
disabled.

Advanced Flag Analysis

For each sample well defined, the Advanced Flag Analysis results will
be printed on a separate page in the PDF report (Figure 91). The output
will list the values within the set criteria of the Advanced Flag analysis.

Smear Analysis

For each selected sample, the Smear Analysis results will be printed
underneath the Peak Table. The color-coded vertical smear range lines
and Average Size (bp) will be also reported (Figure 89).
If no Smear Analysis table is present for the data file, this option will be
disabled.
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Table 53

Generate PDF settings

Settings

Description

Gel Image

Prints a digital gel overlay image of the selected samples on the first
page of the PDF report (Figure 87). If not selected, this field will be blank.

Calibration Curve

Prints a separate page at the end of the PDF report showing the Size
Calibration curve including the well location and fit type used
(Figure 92).
If not selected, this page will be not printed.

Show Integration Parameters
Information

Prints a detailed summary of the individual integration parameters for
each selected sample at the bottom of each sample result page in the
PDF report (Figure 89).
If not selected, this field blank will be blank.

Show Annotation

Shows the annotation(s) made to individual sample electropherograms.
If not selected, no annotation for samples will be shown.

Logo

Allows to import a custom logo (which will print at the top of each page).
This is for customers that want their company logo to be printed on
each page.

Generate PDF report

Generates the configured report. A file browser menu will open to
navigate and save the file in the desired directory. The default directory is
that containing the .raw data file.
In the Message dialog, click OK to open the report; click Cancel to close
without opening the report.

Cancel

Abort the report generation and return the main screen of the software.
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Examples of Generated Reports
Figure 87 through Figure 92 below show examples of the PDF report pages
generated by the ProSize software version 3.0. The header of each page lists the
.raw data file name and the page number; the footer contains software version
and copyright information as well the date and time of report generation.

Figure 87
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Page 1 of PDF report (all fields shown; 12 samples were selected)

ProSize Data Analysis Software User Manual

8

Generating Reports from ProSize
Examples of Generated Reports

Figure 88

Trace Summary of PDF report (all fields shown; 12 samples were selected). Note: When
reporting total RNA data, the RQN is reported.
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Figure 89
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Individual result page of PDF report (all fields shown). Note: When reporting total RNA data, the
rRNA peaks are highlighted and the rRNA ratio and RQN are reported. Not shown: When
reporting Genomic Data, the GQN will be reported.
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Figure 90

Example Flag Analysis table in PDF report

Figure 91

Example Advanced Flag Analysis table in PDF report
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Figure 92
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Example Size Calibration page in PDF report
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This chapter briefly covers the tools and functions of the View Capillary Positions
window.
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About View Capillary Positions
The ProSize software performs an automated capillary alignment procedure
when reading in .raw data files. This ensures that the capillary locations on the
CCD detector selected for data analysis are of maximum fluorescence intensity
for providing the best possible signal to noise ratio.
View Capillary Positions is used to examine the capillary array alignment and the
assigned locations used for data analysis. This option is typically not used in
routine use since the locations are automatically assigned; it serves rather as a
diagnostic/troubleshooting tool.
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Open the View Capillary Positions Window
1 From the main screen of the ProSize software program, select Analysis > View
Capillary Positions.
The View Capillary Positions window opens (Figure 93). Table 54 summarizes
the available functions in this window.

Figure 93

View Capillary Positions utility

The View Capillary Positions window contains two sections:
•

A plot of Capillary Positions (Pixels) vs. Signal Distribution (Intensity), which
shows a summation of fluorescence intensity for each capillary.

•

The Capillary Positions table listing the pixel location for each of the 12, 48,
or 96 capillaries in the 12-capillary, 48-capillary, or 96-capillary array,
respectively.

In Figure 93, a proper alignment is shown where the red Current Positions
symbols are centered on the peaks corresponding to each capillary. The
algorithm automatically detects the peak locations and sets the capillary
positions. If no fluorescence is detected in a particular capillary, the algorithm will
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fill the gap using the spacing between capillaries as a reference. In this way, the
positions of all capillaries are indexed properly, even if no data was generated by
some capillaries of the array.

NOTE

It is important when installing a new capillary array to perform a run with samples
(for example, DNA Ladder or marker plate), followed by performing an optical
alignment using the collected data file (i.e., Read Raw optical alignment function).
This is to ensure that the assigned instrument capillary locations are close to
actual positions. For further information, refer to the Capillary Alignment section
of the System Manual.
During typical operation, no modifications should need to be made to the
capillary positions. In rare occurrences, it may be necessary to adjust the
positions slightly for one or two capillaries, or to manually adjust positions as
described below. provides information on how to change a location and save the
changes. Only changes necessary to center the red Current Positions symbols on
any misaligned capillaries should be performed, to avoid introducing artifacts
into the data.
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View Capillary Positions Window Settings
Table 54 summarizes the settings of View Capillary Positions window.
Table 54

Capillary Positions window functions

Menu Item

Description

Capillary Positions

Lists the pixel locations used on the CCD detector for data analysis. There
are either 12, 48 or 96 cells, each corresponding to a capillary of the array.
The table is labeled by row and well position.

To view a particular capillary position, click the cell in the table, or click on
a peak in the plot of Capillary Positions (Pixels) vs. Signal Distribution
(Intensity) to view the corresponding assigned well. A red vertical cursor
will be displayed on the plot to indicate the detector position.
Reset

Performs an automatic alignment algorithm to reset the capillary
locations. Any manual changes made to the pixel positions will be
overwritten. A blue threshold line will appear (see Figure 94). This line can
be moved up or down to select an appropriate threshold for automatically
determining capillary location.

Method

Two methods for determining capillary location can be used:
• Close Proximity (default): This setting will use the original instrument
alignment file to determine where to locate the capillary positions,
filling any gaps in signal as needed.
• Ignore Original: If the Close Proximity method fails to locate the
correct capillary locations, this will attempt to assign capillary positions
based on the signal positions; press Reset and use the threshold
cursor and Peak Width settings to adjust assignments.

Peak Width

Provides a width threshold for selecting peaks in the plot of Capillary
Positions (Pixels) vs. Signal Distribution (Intensity); a higher value selects
wider peaks while a smaller value selects narrow peaks.
The recommended value is 3.

Undo

To undo the last manual adjustment operation to the Capillary Positions
table.
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Table 54

192

Capillary Positions window functions

Menu Item

Description

Zoom

Enables zooming in the x- and y-axis of the plot of Capillary Positions
(Pixels) vs. Signal Distribution (Intensity).
To zoom-in: Place the mouse over the plot, click and drag it outward to
expand a box area to define the zoom region. Release the mouse button
to apply. .
To undo the zoom, use the Autoscale function.

Autoscale

To autoscale the plot of Capillary Positions (Pixels) vs. Signal Distribution
(Intensity).

Pan

Enables panning of the plot of Capillary Positions (Pixels) vs. Signal
Distribution (Intensity). Move the image around with the mouse cursor:
Place the mouse over the trace and click; drag the cursor to shift the
current view. This is most often used in combination with the Zoom
function.

Accept

Accepts the current Capillary Positions table locations for the capillary
array to use for data analysis and return to the main screen of the ProSize
program.

Cancel

Cancels any manual modification to the Capillary Positions table
locations for the capillary array. It closes the View Capillary Positions
window and return to the main screen of the ProSize program.
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Figure 94

Capillary Positions window after pressing Reset. A blue horizontal cursor can be used to select
the threshold for locating capillary positions.
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Manually Resetting Capillary Positions
In very few situations, it may be necessary to manually relocate the capillary
positions in the View Capillary Positions window. This is usually the result of a
combination of the two following conditions:
•

The instrument optical alignment (i.e., capillary positioning) is not set properly.
When the set capillary locations are far from the actual locations, the ProSize
software will have difficulty locating them automatically, especially for
96-capillary data. Therefore is it very important to ensure the capillary array
locations have been reset and properly aligned after changing a capillary
array.

•

A capillary within the array has no detectable fluorescent signal, either due to
no sample or marker being loaded into the particular sample well, or because
the capillary is plugged.

Ensuring the capillary array is properly aligned will in most all cases enable
automatic detection of capillary locations, even if some capillaries do not
generate signal. In the event, it is necessary to manually adjust or reset a capillary
location, the user should follow the steps outlined below.
Figure 95 shows the View Capillary Positions window for a file where a capillary
signal is missing (118 pixels), and as a result of a slight misalignment of the
instrument optical alignment the software has mistakenly assigned a capillary to
pixel 495 and not assigned a location to the second capillary from the right
(circled). In this instance, it is not possible to adjust the threshold to successfully
select the proper capillaries.
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Figure 95

View Capillary Positions window where capillary is not assigned properly (circled in red)

Figure 96

View Capillary Positions window showing misaligned capillary not reset by threshold

In Figure 96 it is shown that clicking Reset and using the threshold will not
correctly reassign the capillaries due to the low signal from pixel 118.
To manually delete the improper capillary position, click the mouse over the
location, and click [Delete] on the keyboard (Figure 97).
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Figure 97

Manually deleting pixel 495 by selecting it, and click [Delete]

Note in that Figure 98 pixel 495 has now been removed from the Capillary
Positions table and a blank cell is present in H12.

Figure 98

Alignment after manually deleting pixel 495

Next, to manually add a location, click on the adjacent capillary location to where
the user wishes to add the capillary, and insert it by clicking [Insert] on the
keyboard. Click the keyboard arrows to move the newly added vertical red cursor
to the desired location, in this case pixel 684 (Figure 99).
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Once the proper positions have been adjusted, press Accept to accept the current
Capillary Positions table locations for the capillary array and return to the main
screen of the ProSize program. All subsequent data analysis will use the newly
saved capillary locations.

Figure 99

Alignment after clicking [Insert] at the rightmost position and using the keyboard arrow to move
the vertical cursor to pixel 684. Capillary positions are now correctly located. Press Accept to
save.
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This chapter gives an overview of troubleshooting the ProSize software.
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ProSize Software Error Messages
The following table lists some potential error messages or issues that may be
encountered when using the ProSize software and how to correct them.
•

When multiple causes and corrective actions are listed, the items are
presented from most likely to the least likely.

•

If all corrective actions are employed and a problem still persists, contact
your corresponding Agilent Service Representative for additional help.

Further information regarding processing data within can be found in the ProSize
Tutorial Videos under Help > Tutorial Videos.
For hardware related issues, please refer to the individual Reagent Kit User
Manual, or the instrument System Manual.
Table 55

ProSize software error messages

Problem

Cause

Corrective Action

When processing data in main screen, a red
flashing message appears on the bottom
toolbar:
Warning: Mis-match between detected peaks
and ladder assignment! No sizing calibration
curve is established.

1 The number of peaks integrated in
the sample well assigned for size
calibration does not match the
number of fragments in calibration
ladder.
2 Wrong sample well selected for size
calibration ladder.

1 Verify the correct number of peaks
are integrated, adjust as necessary.
Markers should be included in the
calibration ladder table.
2 Verify correct sample well location of
size calibration ladder; reassign in
Size Calibration menu.
For more information, refer to Chapter 5,
“ProSize Size Calibration Screen”.

When generating a PDF report, the following
message is displayed:

1 Another PDF report is open with the
same name.

1 Close any additional open files and
repeat the operation.
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ProSize software error messages

Problem

Cause

Corrective Action

When attempting to integrate a smear, the
baseline does not properly follow the trace.
See example below:

1 The Peak Width (sec) setting is too
low.

1 Increase the Peak Width (sec) setting
until baseline draws properly.
2 Use the Manual Baseline Setpoints
function to set the baseline from
outside of the lower/upper marker
peak region. See Table 25 for further
information.

Peaks are observed in the Electropherogram
Trace view but no corresponding band is seen
in the Digital Gel View.
Example:

1 The Peak Width (sec) setting is too
high.
2 The function Hide/Show
Non-Integrated Peaks on the Digital
Gel Image toolbar is set to hide
non-integrated peaks.

1 Decrease the Peak Width (sec)
setting until peaks are integrated
properly.
2 Toggle the icon to Show
Non-Integrated Peaks.

In RNA mode, the RQN number is stated as
NaN.

1 The concentration of the sample is
too low for the software to
accurately calculate the RQN
number.

1 Increase the injection time of the
sample method to inject more
sample.
2 Increase the concentration of the
sample added to the Diluent Marker.

The lower and/or upper markers do not
properly line up between lanes in the Digital Gel
Image display.

1 The Min. Peak Height (RFU)
threshold is set too high, preventing
the marker peaks from being
selected.
2 Extra peaks (for example,
primer/dimer) that are migrating
close to the marker are being
assigned as the lower marker.

1 Adjust/decrease the Min. Peak
Height (RFU) threshold in the Marker
Analysis tab of the Set Individual
Parameters menu; apply to individual
sample or all samples as needed.
2 Adjust/increase the Min. Peak Height
(RFU) threshold in the Marker
Analysis tab of the Set Individual
Parameters menu; apply to individual
sample or all samples as needed.
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This chapter explains how to perform a batch process and provides an outline of
the various exporting options.
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Batch Processing
The ProSize software can batch process a list of runs within a folder, and send
the parameters/reports to an output folder. If an output folder is not designated,
the data is exported and placed back into the original data folders.
To successfully apply the batch processing routine, the name of the Run Method
in the instrument software must exactly match the configuration method in
ProSize.

Perform a Batch
1 From the menu, select Batch Processing > Batch Data Process.
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The Batch Data Processing window opens (Figure 100). Table 56 summarizes
the available options in this window.

Figure 100

Batch Data Processing window. With open file selection browser to define folder.

Table 56

Batch Data Processing window options

Item

Description

Folder Selection

Allows you to select the folder location with data
files to be batch processed. After locating the folder,
select Current Folder to set the folder location.

Export Path (If empty, uses data path)

Allows you to select a folder location for exported
data. After locating the folder, select Current Folder
to set the folder location.
Note: If this field is left empty, the program will
export the data to the data folders in Folder
Selection above.

Export File Options

Allows you to define an export option available in
data export (PDF, peak table, flag analysis, etc.).

Start

Starts the batch processing routine.
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Table 56

Batch Data Processing window options

Item

Description

Exit

Terminates the batch processing routine and
closes the window.

View Error Log

Opens an Error Log dialog which allows you to
quickly determine errors associated with batch
processing (Figure 101).

To initiate batch processing:
1 In the Batch Data Processing window, under Folder Selection, select
navigate to your folder with the input files.

and

2 Click Current Folder to accept the folder location.
3 Under Export Path, select
files.

and navigate to a folder location for the exported

4 Click Current Folder to accept the folder location.

NOTE

If no folder is selected, the program will export the data back into the original data
folders.
5 Select Start to initiate the process.
Once the batch processing is finished, the Error Log window shows the final
processing status for each file.

To display the batch processing status of the files:
1 Select View Error Log within the Batch Data Processing window.
Or
From the menu, select Batch Processing > View Error Log.

204

ProSize Data Analysis Software User Manual

11

Batch Processing Using ProSize
Perform a Batch

The Error Log window opens (Figure 101). Table 57 describes the output
errors associated with this window.

Figure 101

Error Log window

2 To view the specific error for a file, click the respective file.
A dialog opens and displays information about the error.
3 To open the file in ProSize, close the dialog and double-click on the file.
Detailed information for the error is provided.
A folder with the .txt files of all errors is generated and located under
C:ProSize data analysis software/Error Log (Figure 102).

Figure 102

Generated error text files in C:ProSize data analysis software/Error Log
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Table 57
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Error messages generated by the batch process routine

Error class

Description

Critical Error

1 ProSize cannot find the configuration file (there
is no file with the exact same name as the
method file).
2 A configuration file exists, but ProSize was not
able to apply the sizing calibration.

Input Error

1 The user has specified a table (such as Flag
Analysis or Smear Analysis), but there are no
parameters set up in ProSize to generate these
reports. The user must go to the Set Individual
Parameters screen and set up the appropriate
features (Flag, Smear, Advanced Flag, etc.).

Generation Error

1 The user has specified a table (such as Flag
Analysis or Smear Analysis), but there are no
parameters set up in ProSize to generate these
reports. The user must go to the Set Individual
Parameters screen and set up the appropriate
features (Flag, Smear, Advanced Flag, etc.).
2 The user is using a mode such as DNA, and has
requested a Quality table, which is only available
in the RNA mode.

Individual Error

1 The markers are too broad (FWHM is to large).
2 There are no peaks.
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Activate Enhanced Security Feature
ProSize data analysis software has been updated to include enhanced security
and integrity features.
To use all enhanced security functions, a .db3 run file from enhanced security is
required to run the controller software version 1.2, or higher.

Activate Enhanced Security Feature in the System
Controller Software
1 From the menu, select Admin > Configuration.
2 Select Login Required and Electronic Records.
3 Select Save prior to leaving the configuration screen.
The program will notify you that ProSize versions 3.0, or higher, is required to
read the database files created by the enhanced security enabled software.
All runs performed will now be stored in an encrypted database that can be
read only by ProSize version 3.0, or higher.

Activate Enhanced Security Feature in ProSize
1 From the menu, select Administration > Configuration.

208
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The ProSize Data Analysis Software Login Configuration window opens
(Figure 103).

Figure 103

Login Configuration window

2 To enable the enhanced security features, select Login required, and
afterwards Enable Enhanced Security.
3 Define the other settings as necessary. Table 58 describes the settings
shown in the ProSize Login Configuration window.
Table 58

ProSize Login Configuration settings

Settings

Description

Login required

When selected, ProSize requires a user login. It
does not enable enhanced security compliance.

Enable enhanced security

Enables enhanced security. To enable this option
Login required must be enabled.

Auto logoff time: (minutes):

Designates how long the system is idle prior to
auto-logoff.

Minimum password length:

Sets minimum character length for the user
passwords. An entry of zero indicates no minimum
password length.

Password expiration time (months):

Determines how often a password must be
changed by the user. An entry of zero indicates no
Password expiration time.
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Table 58

ProSize Login Configuration settings

Settings

Description

Allowed login attempts

Set the number of allowed login attempts by the
user. A value of zero indicates no maximum
number of login attempts.

Previous unique passwords

Sets the number of passwords that must be unique
for a single user. A value of zero indicates no
requirements related to previous unique
passwords.

4 Click Accept.
You will be prompted to setup the administrator account.

Figure 104
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Message to setup an administrator account
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5 Select OK to set up the administrator account.
The User Account Setup window opens (Figure 105). The user settings are
described in Table 59.

Figure 105

User Account Setup window
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Table 59
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User account settings

User settings

Description

Name

Enter name of the user.

User ID

Enter a user ID.

Password

Choose a password.
Note: Passwords must follow the requirements
specified in the Login Configuration window
(Figure 103).

Password (Repeat)

Re-enter selected password to confirm accuracy.

Email

Enter an email to be associated with the account.
Note: This is required only if the user wants to
receive e-mail alerts when an invalid login is
attempted.

Access Level

Select one of the three access levels:
Administrator: Unrestricted access, able to change
all user information and modify login settings.
Access to all analysis functions.
Advanced User: Able to set a default data file path,
configuration settings, language, capillary array
format, and display mode. Access to all analysis
functions.
User: The most restricted level with access to
analysis functions but none of the advanced
features the Advanced Users and Administrators
have access to.

eSignature Level

Select one of the three eSignature levels:
Not Allow: Specified user is not allowed to apply or
remove an eSignature.
eSign & un-Sign: Specified user is able to apply and
remove an eSignature.
eSign Only: Specified user may only apply an
eSignature.

Active?

If selected, the account is active.

Receive email alerts

Email will be sent upon termination of ProSize due
to a failed user login (I.e. a failed login attempt).
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Use eSignature
Once a signature is applied to a data file, the further analysis of the data file is
disabled.

To eSign a data file
✔ You must have the appropriate eSignature level (eSign & un-Sign, or eSign only)
to access the eSign menu command (for details, refer to Table 59).
1 Go to eSignature > eSign.

Figure 106

eSignature drop-down menu

The ProSize Data Analysis Software e-Sign Logon window opens (Figure 107).

Figure 107

e-Sign Logon window

2 Enter your user credentials (UserID and password).
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3 Define a Meaning. From the drop-down list, select Author, Review, or Approve.
4 Under Description, enter relevant notes or comments (optional).

To un-Sign a data file
An eSigned data file (.db3 file) can be un-signed again, allowing further analysis.
✔ You must have the appropriate eSignature level (eSign & un-Sign) to access
the un-Sign menu comand (for details, refer to Table 59).
1 Go to eSignature > un-Sign.

Figure 108

eSignature drop-down menu

The ProSize Data Analysis Software e-Sign Logon window opens (Figure 109).

Figure 109

e-Sign Logon window

2 Provide all necessary information. Enter your user credentials (UserID and
password), a meaning, and a description (optional).
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To View eSignature Records
The eSignature Records window provides information of all eSignature events
associated with the data file.
1 From the menu, select eSignature > eSignature Records.

Figure 110

eSignature drop-down menu

The eSignature Records window opens (Figure 111). A description of the fields
is shown in Table 60.

Figure 111

eSignature records for a data file
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Fields shown in the eSignature records window

Field

Description

eSignature

Displays if it is an eSign or an un-Sign event.

UserID

Displays the userID of the user who applied or
removed an eSignature.

Description

Displays any notes the user made concerning the
application or removal of an eSignature.

Date

Displays the Date and Time of all events down to
the second.
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View Event Report
The Event Report window tracks changes made by all registered users in ProSize
for the entire history of ProSize enhanced security enabled software (unless this
file has been archived).
1 From the menu, select Administration > Event Report.

Figure 112

Administration drop-down menu

The Event Report window opens (Figure 113). The report table is described in
the Table 61. Menu items shown in the window are described in Table 62.

Figure 113

Event Report window
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Table 61
Field

Description

UserID

Displays the UserID of the user who applied or
removed an eSignature.

Computer Name

Name of the computer the event occurred on.

Event Time

Date and Time of all events, recorded to the second.

Operation

The type of event performed by the user, for
example, Logon Action, File Open, etc.

File Path

Displays the file paths relevant to the event
performed by the user.

Description

Relevant description about the event performed by
the user.

Table 62
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Fields shown in the Event Report window

Menu items of the Event Report window

Menu item

Description

Archive

Allows the user to save entries as an archive or to
open archived entries (this transfers entries of the
current database to a new, archived database).

Export to CSV

Exports Event Report entries to a .csv file.

PDF

Generates a PDF report of all Event Report entries.

Close

Closes Event Report window.

Range

User selects a period of time to view entries:
• Last 24 Hours
• Last Week
• Last Month
• Last Year
• Beginning of the Year
• All

Export Data to Clipboard

Right-click in the window to open the context menu.
Copies Event Report entries to the clipboard.

Export Data to Excel

Right-click in the window to open the context menu.
Exports Event Report entries to Microsoft Excel.
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View Data Event Log
The Data Event Log window tracks all changes made to a .db3 file (i.e. a specific
data file) reporting User ID, Computer Name, Event Time, Operation and
Description.
1 Open a .db3 file.
2 From the menu, select Administration > Data Event Log.

Figure 114

Access to Data Event Log

The Data Event Log window opens (Figure 115). The menu items shown in the
window are described in Table 63.

Figure 115

Data Event Log window
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Menu items of the Data Event Log window

Menu item

Description

Export to CSV

Exports Data Event Log entries to a .csv file.

PDF

Generates a PDF report of all Data Event Log
entries.

Close

Closes Data Event Log window.

Range

User selects a period of time to view entries:
• Last 24 Hours
• Last Week
• Last Month
• Last Year
• Beginning of the Year
• All

Export Data to Clipboard

Right-click in the window to open the context menu.
Copies Data Event Log entries to the clipboard.

Export Data to Excel

Right-click in the window to open the context menu.
Exports Data Event Log entries to Microsoft Excel.
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This manual contains information about the
ProSize data analysis software.
The manual describes the following:
• System overview,
• Requirements and installation instructions,
• Software main screen and menus,
• Data configuration,
• Comparing samples,
• Data export,
• Report generation,
• TroubleShooting,
• Batch processing,
• Enhanced software features.
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